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Preface
Welcome to the GeneMarkerHTS User’s Manual. The purpose of the GeneMarkerHTS 
User’s Manual is to answer your questions and guide you through the procedures necessary 
to use the GeneMarkerHTS application efficiently and effectively.

Using the manual
You will find the GeneMarkerHTS User’s Manual easy to use. You can simply look up the 
topic that you need in the table of contents or the index. Later, in this Preface, you will find a 
brief discussion of each chapter to further assist you in locating the information that you 
need.

Special information about the manual
The GeneMarkerHTS User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document window for navigation through the document. For better viewing, decrease the 
size of the bookmark frame and use the magnification box to increase the magnification of 
the document to your viewing preference.

Conventions used in the manual
The GeneMarkerHTS User’s Manual uses the following conventions:

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Project Name>. Do 
not type the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

     

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual
The GeneMarkerHTS User’s Manual assumes that:

• You are familiar with Windows-based applications and basic Windows functions, 
commands, and navigational elements.

• References to any third-party standards or third-party software functions were current as 
of the release of this version of GeneMarkerHTS, and might have already changed. 

Organization of the manual
In addition to this Preface, the GeneMarkerHTS User’s Manual contains the following 
chapters:

• Chapter 1, “Getting Started with GeneMarkerHTS,” on page 13 details the installation 
requirements for GeneMarkerHTS, installing GeneMarkerHTS, and activating your 
account. It also explains how to launch GeneMarkerHTS and provides an overview of the 
major navigational elements for GeneMarkerHTS. 

• Chapter 2, “GeneMarkerHTS Project Setup and Management,” on page 49 details the 
New Project dialog box, which provides all the options for adding a new project in 
GeneMarkerHTS. It also explains how to open and work with existing projects in 
GeneMarkerHTS.

• Chapter 3, “GeneMarkerHTS Viewers and Reports,” on page 73 details the three viewers 
that are available in GeneMarkerHTS application for viewing and working with the results 
of an STR/mtDNA projects: the Mito Alignment Viewer, the STR Results Analysis Viewer, 
and the Comparison Viewer. It also details the different reports that are available for your 
mtDNA alignment results.

• Appendix A, “GeneMarkerHTS Application Settings,” on page 145 details the 
GeneMarkerHTS Application Settings dialog box, which provides a variety of settings for 
customizing an GeneMarkerHTS instance to best suit your working needs.

• The Glossary on page 161 is an alphabetical list of the words or phrases that are relevant 
to the understanding and use of GeneMarkerHTS.
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Chapter 1
Getting Started with 
GeneMarkerHTS

The GeneMarkerHTS software application provides a streamlined workflow for mtDNA data 
analysis from massively parallel sequencing (MPS) methods. The software also includes 
analysis of targeted amplicons from STRs and Y-STRs. This chapter details the installation 
requirements for GeneMarkerHTS, installing GeneMarkerHTS, and activating your account. 
It also explains how to launch GeneMarkerHTS and provides an overview of the major 
navigational elements for GeneMarkerHTS. It also details how to customize the layout and 
display of your GeneMarkerHTS instance.

This chapter covers the following topics:

• “GeneMarkerHTS System Requirements” on page 15.

• “Installing GeneMarkerHTS” on page 16.

• “Installing the SoftGenetics License Server Manager” on page 20.

• “Registering a GeneMarkerHTS Network License” on page 25.

• “Registering a GeneMarkerHTS Local License” on page 37.

• “GeneMarkerHTS Registration Common Error Messages” on page 43.

• “Starting GeneMarkerHTS” on page 45.

• “The GeneMarkerHTS Main Window” on page 46.
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GeneMarkerHTS System Requirements
GeneMarkerHTS is currently available only for the Windows operating system. You must 
have Administrator rights for the computer on which you are installing GeneMarkerHTS.

Component Description
OS 64-bit Windows 10 or greater that are within Windows Extended Support.

Processor Intel Core i5 3rd generation (or equivalent) or better

Memory 16 GB RAM (Minimum)

Hard Drive 250 GB of free space (SSD recommended)

Monitor 1366 x 768 or higher resolution monitor
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Installing GeneMarkerHTS
You must contact SoftGenetics directly to obtain the necessary executable file for installing 
GeneMarkerHTS. Note the following caveats when installing GeneMarkerHTS:

• You install GeneMarkerHTS as a standalone application on a Windows client.

• By default, when you install GeneMarkerHTS, the License Type is set to FullAligner, 
which is applicable for a commercial (purchased) installation. 

• A non-commercial installation of GeneMarkerHTS requires that you set the License 
Type to Trial. A Trial license is valid for 35 days. After 35 days, to continue using 
GeneMarkerHTS, you must set the License Type to FullAligner and purchase a 
network or local license.

• A commercial installation of GeneMarkerHTS requires either a network license or a 
local license. 

• For a network license, you must also install the SoftGenetics License Server 
Manager (LSM).The network installation of GeneMarkerHTS is for an unlimited 
number of clients as long as the clients are all on the same network as the LSM. 

• For a local license, you can install GeneMarkerHTS on only a single client. The 
SoftGenetics LSM is not required. You simply register the product.

• A new version of GeneMarkerHTS does not replace the existing version of 
GeneMarkerHTS on a client during installation, even for point release/bug fix installations. 
Each version of GeneMarkerHTS is installed in its own unique directory. You can run 
multiple versions of GeneMarkerHTS on the same client.

• The GeneMarkerHTS installation requires the Microsoft Visual C++ 2015-2022 
Redistributable. If this redistributable is already installed on the client on which you are 
installing GeneMarkerHTS, then no additional action is required during installation; 
otherwise, the GeneMarkerHTS Installation wizard installs the necessary redistributable. 

• A default installation directory–C:\Program Files\SoftGenetics\GeneMarkerHTS–is 
specified for GeneMarkerHTS but you can select a different directory.

• A shortcut icon for the application is created and placed on the client desktop.

• The Start menu folder in which the shortcut to the application is created is set to 
SoftGenetics\GeneMarkerHTS v< >, but you have the option of creating a new folder, or 
you can decline the creation of the shortcut.

Figure 1-1 on page 17 through Figure 1-7 on page 19 show all the possible wizard pages for 
the installation of GeneMarkerHTS. The wizard page that is shown in Figure 1-5 on page 18 
opens only if the wizard must install the required Microsoft redistributable. After installation is 
complete, continue to one of the following as appropriate: 

• For a Trial license: “To set a Trial license” on page 150.

• For a network license: “Installing the SoftGenetics License Server Manager” on page 20.

• For a local license: “Registering a GeneMarkerHTS Local License” on page 37.
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Figure 1-1:  GeneMarkerHTS Installation Wizard, Page 1

Figure 1-2:  GeneMarkerHTS Installation Wizard, Page 2

Figure 1-3:  GeneMarkerHTS Installation Wizard, Page 3
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Figure 1-4:  GeneMarkerHTS Installation Wizard, Page 4

Figure 1-5:  GeneMarkerHTS Installation Wizard, Page 5 

Figure 1-6:  GeneMarkerHTS Installation Wizard, Page 6
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Figure 1-7:  GeneMarkerHTS Installation Wizard, Page 7

To facilitate the registration of GeneMarkerHTS to the SoftGenetics LSM, 
SoftGenetics strongly recommends that you leave the default option of Start 
GeneMarkerHTS selected on the last page of the GeneMarkerHTS installation 
wizard.
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Installing the SoftGenetics License Server 
Manager

If you have installed a purchased version of GeneMarkerHTS, and you have not installed 
any other SoftGenetics products that require the SoftGenetics License Server Manager 
(LSM), then you must also install the SoftGenetics LSM. The LSM is a central location either 
locally or on a network where software application licenses are stored and that 
GeneMarkerHTS users can access. The full installation of the SoftGenetics LSM consists of 
the following steps:

1. Installing the LSM.* 

2. Registering GeneMarkerHTS for the LSM.

3. Configuring GeneMarkerHTS to connect to the LSM.

Before you install the SoftGenetics LSM, note the following:

• You must contact SoftGenetics for assistance in obtaining the executable to install the 
license server. 

• You must install the LSM on a Windows client or server that is always on and running. 
You can install the LSM on the same client that is running GeneMarkerHTS.

• You must be an administrator of the Windows client or server on which you are installing 
the LSM. To satisfy the UAC settings on the client or server, you might also need to run 
the LSM setup file as an administrator. (After you download the file, you can right-click it, 
and then on the context menu that opens, select Run as Administrator.)

• To allow for online registration of the license server, the server/client on which you are 
installing the LSM must be connected to the Internet; otherwise, offline registration is 
required.

• The GeneMarkerHTS installation requires the Microsoft Visual C++ 2017 Redistributable. 
If this redistributable is already installed on the computer on which you are installing the 
LSM, then no additional action is required during installation; otherwise, the LSM 
Installation wizard installs this redistributable.

• The LSM is installed in the following directory, but you have the option of selecting a 
different directory: C:\Program Files (x86)\SoftGenetics\License Server.

• The Start menu folder in which the shortcut to the LSM is created is set to 
SoftGenetics\License Server, but you have the option of creating a new folder, or you can 
decline the creation of the shortcut.

• The network installation of GeneMarkerHTS is for an unlimited number of clients; 
however, you must purchase a license for each concurrent user.

*If you have installed other SoftGenetics products that require the SoftGenetics 
LSM, then you must simply register GeneMarkerHTS with the LSM. See 
“Registering a GeneMarkerHTS Network License” on page 25.
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To install the SoftGenetics LSM
1. Download the SoftGenetics LSM Installation file, and then launch and run 

SrvSetup_<>_exe to install the LSM.

Figure 1-8 below through Figure 1-15 on page 23 show all the possible wizard pages 
that can open when you are installing the SoftGenetics LSM. The wizard page that is 
shown in Figure 1-12 on page 22 opens only if the wizard must install the required 
Microsoft redistributable.

Figure 1-8:  SoftGenetics License Server Installation wizard, Wizard page 1

Figure 1-9:  SoftGenetics License Server Installation wizard, Wizard page 2

     

SoftGenetics strongly recommends that you leave the default option of Start 
License Server selected on the last page of the installation wizard; otherwise, you 
must manually start the LSM before you can register a GeneMarkerHTS network 
license. 
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Figure 1-10:  SoftGenetics License Server Installation wizard, Wizard page 3

Figure 1-11:  SoftGenetics License Server Installation wizard, Wizard page 4

Figure 1-12:  SoftGenetics License Server Installation wizard, Wizard page 5
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Figure 1-13:  SoftGenetics License Server Installation wizard, Wizard page 6

Figure 1-14:  SoftGenetics License Server Installation wizard, Wizard page 7

Figure 1-15:  SoftGenetics License Server Installation wizard, Wizard page 8
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2. After you click Finish on the last page of the SoftGenetics License Server Installation 
wizard, the following three actions occur:

• The SoftGenetics License Server Installation wizard closes.

• An icon for the License Server Manager (LSM) is placed in the system tray. 

Figure 1-16:  SoftGenetics LSM icon in system tray

• A Warning message opens indicating that no product has been registered with the 
LSM and instructing you how to register a product. 

Click OK to close the message and open the LSM. The display is blank. 

Figure 1-17:  Warning message indicating that no product is currently registered

Figure 1-18:  SoftGenetics LSM, No products registered

3. Continue to “Registering a GeneMarkerHTS Network License” on page 25.
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Registering a GeneMarkerHTS Network License
Registering a GeneMarkerHTS network license is a two-step process. First, you must use 
the SoftGenetics LSM register the network license. Second, you must then configure 
GeneMarkerHTS to connect to the LSM.

To register a GeneMarkerHTS network license
1. If the LSM is currently open, go to Step 2; otherwise, in the system tray, click the LSM 

icon.

The LSM opens. If you have installed any other SoftGenetics products that require the 
LSM, then these products and their licensing information are displayed in the LSM; 
otherwise, the display is blank. See Figure 1-20 on page 26.

Figure 1-19:  Optional launching of the SoftGenetics LSM

     

The procedures in this section assume that you are able to carry them out 
error-free. For explanations of the most common error messages that might open 
during GeneMarkerHTS registration and their resolutions, see “GeneMarkerHTS 
Registration Common Error Messages” on page 43.

If the SoftGenetics LSM icon is not present in the system tray, then in the Windows 
Search feature, enter “license” to locate the LSM, and then click Run as 
administrator to open and start the SoftGenetics LSM. See Figure 1-19 below.
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Figure 1-20:  \SoftGenetics LSM, No products registered

2. On the LSM main menu, click Register.

The SoftGenetics Product Registration dialog box opens. The Request ID field is 
pre-populated. 

Figure 1-21:  SoftGenetics Product Registration dialog box

3. Continue to one of the following:

• If the computer on which you installed the LSM has an Internet connection and you 
do not use a proxy server, then continue to “To register a GeneMarkerHTS network 
license with the LSM (No Proxy server)” on page 27.

• If the computer on which you installed the LSM has an Internet connection and you 
are using a Proxy server, then continue to “To register a GeneMarkerHTS network 
license with the LSM using a Proxy server” on page 29.

• If the computer on which you installed the LSM does not have an Internet 
connection, then continue to “To manually register a GeneMarkerHTS network 
license with the LSM” on page 30.
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To register a GeneMarkerHTS network license with the 
LSM (No Proxy server)

1. On the Product drop-down list, select GeneMarkerHTS.

2. Enter the account credentials (Account and Password) that SoftGenetics supplied to 
you.

3. Enter the email address for the account.

4. Click Register. Two results are possible.

• If the registration is successful, then a Registration Success dialog box opens. 
Continue to Step 5.

Figure 1-22:  Registration Success dialog box

• If the registration is not successful, then a Registration Failed dialog box opens. You 
must now manually register GeneMarkerHTS. Continue “To manually register a 
GeneMarkerHTS network license with the LSM” on page 30.

Figure 1-23:  Registration Failed dialog box 

5. Click OK in the Registration Success dialog box.

The Registration Success dialog box closes and an Actions Info dialog box opens, 
indicating that the license server will reload the license data and re-establish client 
connections.

Figure 1-24:  Actions Info dialog box

     

Make sure to select GeneMarkerHTS and not GeneMarkerHTS Viewer.
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6. Click OK.

The Actions Info dialog box closes and the LSM remains open. 

• The newly registered GeneMarkerHTS product is displayed in the LSM. See Figure 
1-25 below.

• A registration email is sent to the email address that you specified. The email 
acknowledges your successful registration and also details your account 
information. See Figure 1-26 below.

Figure 1-25:  License Server Manager

Figure 1-26:  Registration email

7. Close the LSM, and then continue to “To configure the LSM” on page 34.

After the Actions Info dialog box closes, a Message dialog box might open that 
prompts you to restart the LSM for the changes to take effect. Close the Message 
dialog box, and then click Restart Now to complete the registration process.
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To register a GeneMarkerHTS network license with the 
LSM using a Proxy server

If you are using a Proxy server with your GeneMarkerHTS installation, then you must specify 
both your GeneMarkerHTS account settings and the Proxy server settings.

1. On the Product Name drop-down list, select GeneMarkerHTS.

2. Enter the account credentials (Account and Password) that SoftGenetics supplied to 
you.

3. Enter the email address for the account.

4. On the Product Registration dialog box main menu, click File > Proxy Settings.

The Proxy Settings dialog box opens. 

Figure 1-27:  Proxy Settings dialog box

5. On the Proxy Settings dialog box, click Enabled.

6. On the Type drop-down list, select the correct type for your Proxy Server.

7. Enter the Proxy server connection settings in the Host field and the Port field.

8. Enter the login credentials for the server in the Username field and Password field.

9. If applicable, enter any exceptions.

10. Click Save.

The Proxy Settings dialog box closes. The SoftGenetics Product Registration dialog box 
remains open.

11. Continue to Step 4 of “To register a GeneMarkerHTS network license with the LSM (No 
Proxy server)” on page 27.

If you select Default Proxy for Type, then either the proxy settings that are specified 
in Window Edge or the proxy settings that are specified in Windows System 
Settings are used for the connection and you do not need to specify any other 
settings on the Proxy Settings dialog box. Instead, continue to Step 10.
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To manually register a GeneMarkerHTS network license 
with the LSM

If online registration for GeneMarkerHTS fails, then you must manually register 
GeneMarkerHTS with the LSM. Two manual registration options are available:

• If the computer on which you installed the LSM is connected to the Internet, then you can 
try manual registration using a web browser. 

• If the computer on which you installed the LSM is connected to the Internet, but you do 
not want to attempt manual registration using a web browser, or the computer is not 
connected to the Internet, then you must contact SoftGenetics to register the server. 

1. In the Registration Failed dialog box, click OK.

The Registration Failed dialog box closes, and a Try Online dialog box opens, asking 
you if you want to attempt manual registration using a web browser. 

Figure 1-28:  Try online dialog box

2. Select either Yes or No.

• If you select Yes, then the Try online dialog box closes, and you are redirected to a 
registration location on SoftGenetics’s website. Continue to “To manually register 
GeneMarkerHTS using a web browser” on page 30.

• If you select No, then the Try online dialog box closes, and the SoftGenetics Product 
Registration dialog box remains open. Continue to “To manually register 
GeneMarkerHTS offline” on page 33.

To manually register GeneMarkerHTS using a web browser

Figure 1-29:  Manual registration of GeneMarkerHTS using a web browser

The option to manually register GeneMarkerHTS using a web browser is also 
available on the Product Registration dialog box: File > Open Website Registration.
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1. On the web browser page, click Register.

The web page is refreshed with a Registration message indicating that you have 
successfully registered GeneMarkerHTS and that you must complete the registration 
process. The page also displays the necessary Registration ID (the registration code) for 
completing the registration. 

Figure 1-30:  Manual registration of GeneMarkerHTS using a web browser

2. On the web page, below the Registration code, click Copy To Clipboard.

3. Return to the SoftGenetics Production Registration dialog box and paste the copied 
Registration ID (the registration code) into the Registration Code field.

4. Click Register.

A Registration Success dialog box opens. 

Figure 1-31:  Registration Success dialog box

5. Click OK.

The Registration Success dialog box closes, and an Actions Info dialog box opens, 
indicating that the license server will reload the license data and re-establish client 
connections. 

Figure 1-32:  Actions Info dialog box

Manual Registration should already be selected on the SoftGenetics Product 
Registration dialog box, but before you continue to the next step, make sure that it 
is selected. If it is not selected, then you must select it.
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6. Click OK.

The Actions Info dialog box closes and the LSM remains open. 

• The newly registered GeneMarkerHTS product is displayed in the LSM. See Figure 
1-33 below.

• A registration email is sent to the email address that you specified. The email 
acknowledges your successful registration and also details your account 
information. See Figure 1-34 below.

Figure 1-33:  License Server Manager

Figure 1-34:  Registration email

7. Close the LSM, and then continue to “To configure the LSM” on page 34.

After the Actions Info dialog box closes, a Message dialog box might open that 
prompts you to restart the LSM for the changes to take effect. Close the dialog 
box, and then click Restart Now to complete the registration process.
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To manually register GeneMarkerHTS offline
1. Copy the entire Request ID string that is displayed in the Request ID field on the 

SoftGenetics Product Registration dialog box.

2. Paste the copied Request ID string into an email that includes your account credentials 
(Account, Password, and Email) and send the email to tech_support@softgenetics.com. 

SoftGenetics emails you a new Registration ID (the registration code).

3. Copy the new Registration ID in this email to your client clipboard.

4. Return to the SoftGenetics Production Registration dialog box, ensure that your account 
credentials are still correctly entered (Name, Password, and Email), and then paste the 
copied Registration ID (the registration code) into the Registration Code field.

5. Click Register.

A Registration Success dialog box opens. 

Figure 1-35:  Registration Success dialog box

6. Click OK.

The Registration Success dialog box closes, and an Actions Info dialog box opens, 
indicating that the license server will reload the license data and re-establish client 
connections. 

Figure 1-36:  Actions Info dialog box

7. Click OK.

The Actions Info dialog box closes and the LSM remains open. 

Manual Registration should already be selected on the SoftGenetics Product 
Registration dialog box, but before you continue to the next step, make sure that it 
is selected. If it is not selected, then you must select it.

After the Actions Info dialog box closes, a Message dialog box might open that 
prompts you to restart the LSM for the changes to take effect. Close the dialog 
box, and then click Restart Now to complete the registration process.

mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry - Register Product Offline
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• The newly registered GeneMarkerHTS product is displayed in the LSM. See Figure 
1-37 below.

• A registration email is sent to the email address that you specified. The email 
acknowledges your successful registration and also details your account 
information. See Figure 1-38 below.

Figure 1-37:  License Server Manager

Figure 1-38:  Registration email

8. Close the LSM and then continue to “To configure the LSM” below.

To configure the LSM
1. If the Application Settings dialog box is not already open, then open it and ensure that 

the License pane is visible.

2. Next to the Type drop-down list, ensure that FullAligner is displayed, and then click 
Configure. 

The Manage License dialog box opens. See Figure 1-39 on page 35.
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Figure 1-39:  Manage License dialog box

3. Click Configure.

The Configure License Server dialog box opens. 

Figure 1-40:  Configure License Server dialog box

4. Do one of the following:

• If the LSM and GeneMarkerHTS are installed on different computers, then in the 
Host field, enter the Fully Qualified Domain Name or IP address for the LSM. 

• If the LSM and GeneMarkerHTS are installed on the same computer, then leave 
Host set to localhost.

5. Leave the Port set to 50000.

6. Click Connect.

Messages are displayed in the Connection Log pane indicating that connection request 
was successful and that GeneMarkerHTS has accessed the commercial license.

7. Click OK.

The Configure License Server dialog box closes. The Application Settings dialog box 
remains open.
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8. Close the Application Settings dialog box.

GeneMarkerHTS is now ready for use.
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Registering a GeneMarkerHTS Local License
You register a GeneMarkerHTS local license directly with SoftGenetics. If the client on which 
you installed GeneMarkerHTS is connected to the Internet, then online registration is 
possible; otherwise, if online registration fails, or if you do not want to register the 
GeneMarkerHTS license online, then you must manually register the GeneMarkerHTS 
license.

To register a GeneMarkerHTS local license online
1. On the GeneMarkerHTS main window, click the Application Settings icon. 

The Application Settings dialog box opens. From top to bottom, the dialog box has three 
panes: General, License, and Visuals.

2. Ensure that the License pane is visible.

The pane indicates that GeneMarkerHTS was installed with a FullAligner license.

Figure 1-41:  Application Settings dialog box, License pane with FullAligner license

3. Click Configure.

The Manage License dialog box opens. The License Type is set to Network.

Figure 1-42:  Manage License dialog box

The procedures in this section assume that you are able to carry them out 
error-free. For explanations of the most common error messages that might open 
during GeneMarkerHTS registration and their resolutions, see “GeneMarkerHTS 
Registration Common Error Messages” on page 43.
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4. On the Choose a License Type drop-down list, select Local (softkey).

5. Click Configure.

The SoftGenetics Product Registration dialog box opens. The Request ID field is pre-
populated. 

Figure 1-43:  SoftGenetics Product Registration dialog box

1. On the Product drop-down list, select GeneMarkerHTS.

2. Enter the account credentials (Account and Password) that SoftGenetics supplied to 
you.

3. Enter the email address for the account.

4. Click Register. Two results are possible.

• If the registration is successful, then a Registration Success dialog box opens. 
Continue to Step 5.

Figure 1-44:  Registration Successful message

• If the registration is not successful, then a Registration Failed dialog box opens. 
(See Figure 1-45 on page 39.) You must now manually register GeneMarkerHTS. 
Continue “To manually register GeneMarkerHTS offline” on page 41.

     

Make sure to select GeneMarkerHTS and not GeneMarkerHTS Viewer.
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Figure 1-45:  Registration Failed message

5. Click OK in the Registration Success message.

The Registration Success message closes. The Application Settings dialog box remains 
open. GeneMarkerHTS is now ready for use.

To manually register a GeneMarkerHTS local license 
If online registration for your GeneMarkerHTS local license fails, then you must manually 
register GeneMarkerHTS with SoftGenetics. Two manual registration options are available:

• If the client on which you installed GeneMarkerHTS is connected to the Internet, then you 
can try manual registration using a web browser. 

• If the client on which you installed GeneMarkerHTS is connected to the Internet, but you 
do not want to attempt manual registration using a web browser, or the client is not 
connected to the Internet, then you must contact SoftGenetics to register the application. 

1. In the Registration Failed dialog box, click OK.

The Registration Failed dialog box closes, and a Try Online dialog box opens, asking 
you if you want to attempt manual registration using a web browser. 

Figure 1-46:  Try online dialog box

2. Select either Yes or No.

• If you select Yes, then the Try online dialog box closes, and you are redirected to a 
registration location on SoftGenetics’s website. Continue to “To manually register 
GeneMarkerHTS using a web browser” on page 40.

• If you select No, then the Try online dialog box closes, and the SoftGenetics Product 
Registration dialog box remains open. Continue to “To manually register 
GeneMarkerHTS offline” on page 33.
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To manually register GeneMarkerHTS using a web browser

Figure 1-47:  Manual registration of GeneMarkerHTS using a web browser

1. On the web browser page, click Register.

The web page is refreshed with a Registration message indicating that you have 
successfully registered GeneMarkerHTS and that you must complete the registration 
process. The page also displays the necessary Registration ID (the registration code) for 
completing the registration. 

Figure 1-48:  Manual registration of GeneMarkerHTS using a web browser

2. On the web page, below the Registration code, click Copy To Clipboard.

3. Return to the SoftGenetics Production Registration dialog box and paste the copied 
Registration ID (the registration code) into the Registration Code field.

4. Click Register.

A Registration Success dialog box opens. See Figure 1-49 on page 41.

     

The option to manually register GeneMarkerHTS using a web browser is also 
available on the Product Registration dialog box: File > Open Website Registration.

Manual Registration should already be selected on the SoftGenetics Product 
Registration dialog box, but before you continue to the next step, make sure that it 
is selected. If it is not selected, then you must select it.
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Figure 1-49:  Registration Success dialog box

5. Click OK.

The Registration Success dialog box closes. A registration email is sent to the email 
address that you specified. The email acknowledges your successful registration and 
also details your account information. GeneMarkerHTS is now ready for use.

Figure 1-50:  Registration email

To manually register GeneMarkerHTS offline
1. Copy the entire Request ID string that is displayed in the Request ID field on the 

SoftGenetics Product Registration dialog box.

2. Paste the copied Request ID string into an email that includes your account credentials 
(Account, Password, and Email) and send the email to tech_support@softgenetics.com. 

SoftGenetics emails you a new Registration ID (the registration code).

3. Copy the new Registration ID in this email to your client clipboard.

4. Return to the SoftGenetics Production Registration dialog box, ensure that your account 
credentials are still correctly entered (Name, Password, and Email), and then paste the 
copied Registration ID (the registration code) into the Registration Code field.

5. Click Register.

A Registration Success dialog box opens. See Figure 1-51 on page 42.

     

Manual Registration should already be selected on the SoftGenetics Product 
Registration dialog box, but before you continue to the next step, make sure that it 
is selected. If it is not selected, then you must select it.

mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry - Register Product Offline
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Figure 1-51:  Registration Success dialog box

6. Click OK.

The Registration Success dialog box closes. A registration email is sent to the email 
address that you specified. The email acknowledges your successful registration and 
also details your account information. GeneMarkerHTS is now ready for use.

Figure 1-52:  Registration email
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GeneMarkerHTS Registration Common Error 
Messages

This section details the four most common error messages that you might encounter when 
you are registering your GeneMarkerHTS installation with the SoftGenetics LSM for a 
network license, or with SoftGenetics directly for a local license. It also describes the most 
appropriate resolution. If you cannot resolve an error message that opens during the 
registration of GeneMarkerHTS, or if you receive an error message that is not detailed here, 
then contact tech_support@softgenetics.com for assistance.

Meaning: The password that you entered on the Product Registration dialog box is not for the 
selected product or the indicated account. 
Resolution:
• Confirm that the correct product is selected on the Product drop-down list.
• Confirm that the account name and password have been entered correctly, remembering that 

both are case-sensitive and there should be no spaces for either registration variable.

Note: If you leave a space at the end of the registration password, this error message is triggered.

Meaning: Your GeneMarkerHTS license has expired and is no longer working. 
Resolution: Contact tech_support@softgenetics.com or your local distributor for assistance in 
updating your license.

Meaning: Your GeneMarkerHTS network license is already actively registered to another client. 
Resolution: Contact tech_support@softgenetics.com for assistance.

mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry
mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry
mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry
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Meaning: The client on which you are registering GeneMarkerHTS was unable to access the 
SoftGenetics database through the Internet. Online registration has failed. This error is typically due 
to firewalls or other security settings. 
Resolution: You must manually register your product. See “To manually register a GeneMarkerHTS 
network license with the LSM” on page 30.
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Starting GeneMarkerHTS
You can double-click the desktop icon to launch GeneMarkerHTS, or you can select the 
option from your Start menu, where the default value is: Start > SoftGenetics > 
GeneMarkerHTS v< >.

Figure 1-53:  GeneMarkerHTS desktop icon

After you start GeneMarkerHTS, the GeneMarkerHTS main window opens. See “The 
GeneMarkerHTS Main Window” on page 46.

Figure 1-54:  GeneMarkerHTS main window
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The GeneMarkerHTS Main Window
The GeneMarkerHTS main window is your starting point for the GeneMarkerHTS 
application. 

Figure 1-55:  GeneMarkerHTS main window

The GeneMarkerHTS main window has seven major components, which are the:

• Title bar. See “Title bar” below.

• Main menu. See “Main menu” on page 47.

• Application Settings icon. See “Application Settings icon” on page 47.

• Project options. See “Project options” on page 47.

• About button. See “About button” on page 48.

• Help button. See “Help button” on page 48.

• Status bar. See “Status bar” on page 48.

Title bar
The name “GeneMarkerHTS” is displayed in the left corner of title bar at the top of the 
GeneMarkerHTS main window. The version of GeneMarkerHTS that you are running is 
displayed after the name. 

Figure 1-56:  GeneMarkerHTS Title bar
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Main menu
The GeneMarkerHTS main menu is displayed below the title bar. The main menu is set up in 
a standard Windows menu format with menu commands grouped into menus (File, Tools, 
and Help) on the menu bar. Some commands are available in other areas of the application.

Figure 1-57:  GeneMarkerHTS main menu

Application Settings icon
The Application Settings icon ( ) is displayed in the left corner of the main window 
underneath the main menu. Click the icon to open the Application Settings dialog box, which 
provides all the options for specifying the settings to customize your GeneMarkerHTS 
instance, including project directory information, license information, and visual settings, 
including colors. See Appendix A, “GeneMarkerHTS Application Settings,” on page 145.

Project options
The Project options—New, Open, and Manage—are displayed in the center of the main 
window underneath the title bar. 

• Click New to open the New Project dialog box, and set up a new analysis project in 
GeneMarkerHTS. 

Menu Option
File • New Project: Click to open the New Project dialog box, and set up a new analysis 

project in GeneMarkerHTS.

• Open Project: Click to open the Open Project dialog box and browse to and select an 
existing GeneMarkerHTS project with which to work.

Note: By default, GeneMarkerHTS opens the folder in which the last project was 
opened for the GeneMarkerHTS instance. 

• Open Recent: Opens a drop-down list of the ten most recent projects that were 
added or edited for the GeneMarkerHTS instance.

• Open Recent > Clear Recent Projects: Click to clear all the recent projects that have 
been opened for the GeneMarkerHTS instance.

• Settings: Click to open the Application Settings dialog box, which provides a variety 
of options for customizing your GeneMarkerHTS instance. See Appendix A, 
“GeneMarkerHTS Application Settings,” on page 145.

Tools • Panel Manager: TBD. If you need assistance with creating or editing custom panels 
for your GeneMarkerHTS instance, contact tech_support@softgenetics.com.

• Motif Editor: Click to open the Motif Editor dialog box, which provide the options 
(Add, Remove Motif, Remove Region) for managing the motifs for the 
GeneMarkerHTS instance. See “To create or edit a custom motif” on page 54.

Help • Help: Click to open the Online Help for GeneMarkerHTS.

• About: Click to open the About dialog box, which displays information about your 
GeneMarkerHTS installation, including the version.

mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry
mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry
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• Click Open to open the Open Project dialog box and browse to and select an existing 
GeneMarkerHTS project with which to work.

See Chapter 2, “GeneMarkerHTS Project Setup and Management,” on page 49.

About button
The About button is displayed in the top right corner of the main window underneath the title 
bar. Click About to open the About GeneMarkerHTS dialog box, which displays information 
about your GeneMarkerHTS installation, including the version. The About dialog box also 
contains a Copy to Clipboard button, which you can use to copy the version and build date 
information that is displayed in the dialog box to your client’s clipboard. You can then paste 
this information into a third-party application such as Microsoft Outlook email in the event 
that you must supply it to SoftGenetics.

Figure 1-58:  About GeneMarkerHTS dialog box

Help button
The Help button is displayed in the top right corner of the main window underneath the title 
bar. Click the Help button to open the online help for GeneMarkerHTS.

Status bar
The Status bar is displayed in the lower right corner of the GeneMarkerHTS main window. 
From left to right, it displays the following information: The license type for the installation, 
the number of days that are remaining on the license, and the version number for the 
installation.

Figure 1-59:  GeneMarkerHTS main window Status bar

The full functionality of project management (Manage) in GeneMarkerHTS is 
currently under development.
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GeneMarkerHTS provides a validated streamlined workflow for forensic mitochondrial, STR, 
and Y-STR casework as well as medical research of mitochondrial DNA from massively 
parallel sequencing platforms (MPS) such as the Illumina and Ion Torrent. The New Project 
dialog box provides all the options for adding a new project for mtDNA, STR, or Y-STR data 
analysis. You can also open and work with existing projects in GeneMarkerHTS. This 
chapter details all the options and functions that are available for setting up and managing 
your GeneMarkerHTS projects.

This chapter covers the following topics:

• “New Project Dialog Box Settings” on page 51.

• “Working with a GeneMarkerHTS Project” on page 64.

• “GeneMarkerHTS Project Output Files” on page 70.
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New Project Dialog Box Settings
You use the New Project dialog box to set up a new project for analyzing your data. You 
select the data that is to be analyzed for a project in the dialog box, and you also specify all 
the project settings in the dialog box. To open the New Project dialog box, do one of the 
following:

• At the top of the GeneMarkerHTS main window, click New.

• On the GeneMarkerHTS main menu, click File > New Project.

Figure 2-1:  New Project dialog box

See:

• “Folders and Paths” on page 52.

• “Motifs” on page 52. 

• “Panel and Panel Options” on page 56.

• “Alignment Options: Optional Steps” on page 56.

• “Alignment Options: Filters/Clipping” on page 57.

• “Amplicon Settings” on page 59.

• “PHI Settings” on page 61.

The following sections describe the settings on the New Project dialog box the first 
time that the dialog box is opened. Any selections that you make are persistent 
within your GeneMarkerHTS instance and across instances on the same client.
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Folders and Paths

Motifs

Setting Description
Project Folder The folder in which to save the project file. The default location is the 

folder in which the project sample files are saved. For example, if the 
project sample files are saved in C:\GM_HTS\Project_A_SampleFiles, 
then the project file is also saved in \GM_HTS\Project_A_SampleFiles. To 
select a different location, next to the Project Folder field, click the Browse 
button to open the Project Save Location dialog box, and then browse to 
and select a different folder.

Note: For additional project directory options, including remembering the 
last opened sample files directory, see “Configuring 
GeneMarkerHTS Project Directory Settings” on page 148.

Reference Path
Use Default Reference

Do one of the following:
• To use the revised Cambridge reference sequence (rCRS) that is 

supplied with GeneMarkerHTS, select Use Default Reference.
• To use a different reference, clear Use Default Reference, and then 

next to the Reference Path field, click the Browse button to open the 
Open Reference dialog box, and then browse to and select the 
reference. 

Warning: If you select a different reference, then it must be in either 
FASTA or GBK format.

Setting Description
Note: Motif options are available only if Motifs is selected for an Alignment option. (See “Alignment 

Options: Optional Steps” on page 56.) If Motifs is not selected as an alignment option, then 
all Motif options are unavailable. SoftGenetics recommends the use of a motif for mtDNA 
analysis.

Motif Path
Use Default Motif

You can use a motif (a .txt file) to adjust the alignment to meet the 
expectations of your analysis. See “Overview of using a motif” on page 
53. You can use the default motif that is supplied with GeneMarkerHTS or 
you can use a custom motif.

• To use the default motif that is supplied with GeneMarkerHTS, leave 
Use Default Motif selected.

• To use the default motif as your starting point for creating a custom 
motif:
1. Clear Use Default Motif.
2. Click Create Motif, and then continue to “To create or edit a custom 

motif” on page 54.
• To use an existing custom motif as your starting point for creating 

another custom motif:
1. Clear Use Default Motif.
2. Click the Browse button that is displayed to the right of the Motif 

Path field, and browse to and select the motif. 
3. Click Edit Motif, and then continue “To create or edit a custom motif” 

on page 54.
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Overview of using a motif

Traditionally, alignment is focused on minimizing the number of mismatches between the 
reference and a sample read, or a “best fit” alignment; however, because forensic analysis 
has established conventions for the position of many common variants, this traditional 
approach to alignment is not always preferred when analyzing mtDNA. As a result, 
GeneMarkerHTS provides the option of using a motif to better meet your analysis 
requirements. A motif is a list of variant calls within a specified region that are translated into 
an expected sequence. You define this list of variant calls in a motif file, which is a text (.txt) 
file that has the following format:

• The first line for each motif definition in the file is preceded with a hash tag/pound symbol 
(#) and this line identifies the start and end points for the region.

• The variant calls in the motif file are listed with standard forensic nomenclature, for 
example, Deletion: 16191d, Insertion: 16193.1C, and SNP: 1184A.

Figure 2-2:  Example of Best Fit alignment compared to Forensic alignment

When you are creating a motif file, note the following:

• Spacing of the variants is not absolute, but you must use commas to separate the variant 
calls.

• Regions cannot overlap. 

• No two motifs in the same region can resolve to the same sequence.

Create Motif Available only if Use Default Motif is not selected. Click to open the Motif 
Editor dialog box and use the default motif that is supplied with 
GeneMarkerHTS as your starting point for creating a custom motif. See 
“To create or edit a custom motif” on page 54.

Edit Motif Available only if Use Default Motif is not selected and you have selected 
an existing custom motif to use as your starting point for creating another 
custom motif. Click to open the Motif Editor dialog box and use the 
selected custom motif. See “To create or edit a custom motif” on page 54.

Setting Description

Hash (#) mark indicates 
motif region.
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If you elect to use motif alignment, then the alignments of reads that cross motif regions with 
expected sequences are adjusted to match the list of variants. Reads that start or end in 
motif regions are soft-clipped. You can use the default motif that is supplied with 
GeneMarkerHTS, or you can use an existing custom motif to create and/or edit your own 
custom motifs. See “To create or edit a custom motif” below.

To create or edit a custom motif

Figure 2-3:  Motif Editor dialog box

1. For each motif region, do any or all of the following:

When creating a custom motif, you can use the default version that is supplied with 
Version 2.6 of GeneMarkerHTS as your starting point, or you can use a prior 
version. All prior versions of the default motif are found in the Resources folder in 
the installation directory for GeneMarkerHTS.

Although you can manually edit a motif file, SoftGenetics strongly recommends 
that you use the built-in Motif Editor instead.

Option Description
Update range Adjust the Start and/or End values for a motif region (manually edit the values, 

or use the Up Arrow/Down Arrow buttons to adjust the value one base at a 
time), and then click Update Range.

Tip: Because motifs require exact matches, shorter motifs are better for 
alignment.

Add Motif Adds a new motif as the last in the list of displayed motifs for the region. The 
default sequence for a new motif is always set to the reference sequence. 

Remove Motif Select a motif, and then click to remove the selected motif from the motif region.

Remove Region Click to remove a region entirely from the motif.
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2. If you are done with customizing the motif, then continue to Step 3; otherwise, optionally, 
to add one or more regions to the motif, do the following:

a. Click Add Region.

A blank new region placeholder is displayed at the bottom of the Motif Editor dialog 
box. 

Figure 2-4:  Motif Editor dialog box with a new region placeholder

b. Specify the start and end positions for the new region, and then click Update Range.

c. Create the needed motifs for the new range. (See Step 1.)

3. Optionally, to check for errors before saving the customized motif, click Check For 
Errors; otherwise go to Step 4.

If errors exist in the customized motif, then a Motif File Errors dialog box that details the 
errors in the motif file opens; otherwise, the Motif File Errors dialog box displays the 
message “No Errors.” 

4. Click OK to close the Motif File Errors dialog box.

• If the file did not contain any errors, then continue to Step 5.

• If the file did contain errors, then iteratively correct the file and click Check For Errors 
until you receive the message “No Errors,” and then continue to Step 5.

     

Use the scroll bar on the right side of the dialog box to scroll to the bottom of the 
dialog box and view the placeholder region.
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5. To save the new motif file, click Save As. 

The Save Motif dialog box opens. The file format is set to .txt and you cannot edit this. 

6. Specify the name for the motif file, and then browse to and select the location in which to 
save the file, and then click Save.

The Save Motif dialog box closes. The Motif Editor dialog box remains open.

7. Click “X” to close the Motif Editor dialog box. 

You return to the New Project dialog box. The full path to the customized motif file, 
including the file name, is displayed in the Motif Path field. You can now use the motif for 
mtDNA analysis.

Panel and Panel Options

Alignment Options: Optional Steps
You can select one or more, or all of the following optional steps.

Setting Description
Panel Required for STR data. Optional for mtDNA data. Leave Panel set to 

the default value of None or, on the Panel dropdown list, select from 
one of the four pre-supplied panels from Promega:
• Promega_Powerseq_46GY_v1 (STRs and Y-STRs)
• Promega_Powerseq_CRM_v1 (mtDNA only)
• Promega_Powerseq_56GMY_v1 (STRs, Y-STRs, and mtDNA)
• Promega_Powerseq_WholeMito_v1 (mtDNA only)

Note: For a complete description of the available panels, see https://
www.promega.com and search for the specific panel in which 
you are interested. If you need assistance in creating panels for 
other chemistries, contact tech_support@softgenetics.com.

Allow Primer Mismatches If selected, then a 1 bp difference in primer binding regions is allowed.

Setting Description
Consensus Selected by default. Do local indel realignment based on the 

consensus sequence. After variant calls are made based on the initial 
alignment, any reads that overlap indels but do not contain the indels 
are adjusted to include the indels if the new alignment is at least as 
good as the initial alignment.

Remove PCR Duplicates Reads are identified as PCR duplicates based on their start positions. If 
you are using paired-end data, then each pair of reads is considered 
together. If you leave the option unselected, then the PCR duplicates 
are not removed; otherwise, select the option to remove PCR 
duplicates.

Note: If you are using targeted sequencing, then you typically do not 
select this value. If you are using whole genome sequencing, 
then you typically do select this value.

https://www.promega.com/
https://www.promega.com/
mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry
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Alignment Options: Filters/Clipping

Keep Only Proper Pairs Ignore any reads that were not marked as being part of a proper pair, 
where a proper pair is defined as the following:
• Both reads from the pair must be aligned and the alignment must be 

on opposite strands.
• The 5’ end of the reverse read must be to the right of the 5’ end of 

the forward read.

Merge Pairs Applicable only for mtDNA data that does not use a panel. If the reads 
are expected to fully overlap, then Merge Pairs is appropriate for 
mtDNA data. If you select Merge Pairs, then the overlapped portion of 
pairs is combined, which reduces coverage; however, because double 
counting is prevented, accuracy might be improved. 
If you select Merge Pairs, then the following options are enabled, and 
you can select one:
• Pre-alignment merging: Selected by default. Results in slower data 

analysis and is more prone to error, especially in repetitive regions, 
but for certain situations such as those that involve high quality data 
and/or sequences that are not highly repetitive, then selecting this 
option can improve alignment.

• Post-alignment merging: Because the reads might already be 
correctly overlapped after alignment, selecting this option results in 
faster data analysis. 

Tip: If you are not sure as to which option to select, analyze the data 
using both options, compare the results, and then make your 
selection.

Motifs Selected by default. The alignments of reads that cross motif regions 
with expected sequences are adjusted to match the list of variants. See 
“Overview of using a motif” on page 53.

Note: This is a default setting for all the Sequencer options (Ion 
Torrent, Illumina, and Other). If you do not want to use motifs, 
then you must manually clear this option.

Setting Description
Match Proportion Include the read if the proportion of the read that is aligned and not 

soft-clipped is greater than or equal to the indicated value, where the 
default value is Percent >=90.

Note: Soft-clipping can be carried out only if the proportion of the read 
that is aligned and not soft-clipped is greater than or equal to 
the indicated value.

Tip: You should set this value to < 90% if you have a larger number of 
variants in the middle for the reads and you need more reads to 
align. Conversely, if your reads are of higher quality, particularly 
for the ends, then less reads need to align and you can set this to 
value to >90%.

Setting Description
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Soft clipping based on quality scores 

If the base call quality is less than or equal to the quality score that is specified in the 
Alignment Settings for a project, then the 3’ ends of reads are soft-clipped. If mismatched 
bases are found near the end of the alignment, then soft clipping is also carried out on the 3’ 
ends of reads according to the following:

1. Starting at the end of the alignment sequence, move towards the middle of the alignment 
sequence, with a quality score for each nucleotide in the sequence calculated as follows.

Add 1 for a matched base; otherwise, subtract 3 for a mismatched base. A quality score 
< -(6) is not allowed.

2. Continue calculating a quality score for each base in the alignment sequence until a 
nucleotide with a quality score of 6 is found.

3. Move back from this position towards the end of the read until a mismatch is found.

4. Soft clip from this mismatch through the end of the read.

For example, if the alignment results in a CIGAR string of 100=2X10=1X3=. then:

• A score is calculated going back from the end: 0,1, 2, 3, 0,1, 2, 3, 4, 5, 6.

• Moving back to the end, soft clipping is started at the first mismatch through the end, 
which results in four bases total being soft-clipped: 100=2X10=4S.

Identity Reads that are less similar to the reference than indicated value are not 
aligned. Select the way to identify the number of reads:
• Percent >=: Selected by default. Default value is 90. If the 

percentage of reads for a sample that do not match the reference 
are greater than or equal to the indicated value, then reads are not 
aligned.

• Number <=: Default value is 0. If the total number of reads for a 
sample that align to reference are less than or equal to the indicated 
value, then the reads are not aligned. 

Soft Clipping at 3’ Q < When the base call quality is less than or equal to the indicated quality 
score, then the 3’ ends of reads are trimmed accordingly. See “Soft 
clipping based on quality scores” below.

Note: GeneMarkerHTS automatically adjusts the default values for both Identity and Soft Clipping 
based on the selected sequencer. The default settings are based on using an Illumina or Ion 
Torrent sequencer. If you change the value for either one or both of the settings, then 
GeneMarkerHTS automatically selects “Other” for Sequencer.

Clip mismatched ends Selected by default. If mismatched bases are found near the end of the 
alignment, then soft clipping is also carried out on the 3’ ends of reads.

Tip: When carrying out panel analysis for mtDNA amplicons, you can 
clear this option to improve trimming if variants are at a boundary.

See “Soft clipping based on quality scores” below.

Setting Description
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Amplicon Settings
Available only if Panel is set to None. Opens the Amplicon Settings dialog box, which 
contains the settings for specifying which amplicon-sequenced regions were used for the 
mtDNA alignment project. See “Specifying amplicon regions” below.

Specifying amplicon regions

The Amplicon Settings dialog box contains the settings for specifying which 
amplicon-sequenced regions were used for the mtDNA alignment project. If you select 
Amplicon Settings for an mtDNA alignment project, then you must do one of the following:

• You must load a BED file that includes the amplicon regions. 

• You must manually add the amplicon regions.

1. On the New Project dialog box, click Amplicon Settings.

The Amplicon Settings dialog box opens.

Figure 2-5:  Amplicon Settings dialog box

2. Continue to one of the following:

• “To load an amplicon BED file” below.

• “To manually add amplicon regions” on page 60.

To load an amplicon BED file
1. Click Load BED file.

The Open BED file dialog box opens. See Figure 2-6 on page 60.
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Figure 2-6:  Open BED File dialog box

2. Browse to and select the existing amplicon BED file, and then click Open to select the 
BED file.

The Open BED File dialog box closes. The position for the BED file are displayed in the 
dialog box.

3. Leave Strict Sort Paired Reads selected, or optionally, clear the setting.

4. Click OK.

The Open BED File dialog box closes. The New Project dialog box remains open.

5. Continue with setting up the new GeneMarkerHTS project.

To manually add amplicon regions
You can manually add as many amplicon regions as needed.

1. For every region that you must add to the BED file, click Add.

A new amplicon region is displayed in the Amplicon Settings dialog box. As you add a 
new region, it is numbered sequentially. By default, the chromosome is set to M, and 
both the Start and End positions are set to “1,” but you can edit any or all these values. 

Figure 2-7:  New amplicon region

If Strict Sort Paired Reads is selected, then the paired reads sort to the same 
amplicon. If Strict Sort Paired Reads is not selected, then the two reads can sort to 
different amplicons. Each read, however, still sorts to only a single amplicon.

For detailed information about the format for a BED file, see “BED file” on page 
161.
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2. As you manually add new amplicon regions, the following options are also available:

• Remove: Click to remove a selected amplicon region. You can remove only a single 
amplicon region at a time. After you remove a region, the remaining regions are 
automatically re-numbered. 

• Remove All: Click to remove all amplicon regions in a single step.

3. Leave Strict Sort Paired Reads selected, or optionally, clear the setting.

4. Click OK.

The Open BED File dialog box closes. The New Project dialog box remains open.

5. Continue with setting up the new GeneMarkerHTS project.

PHI Settings
Opens the PHI Settings dialog box. You use the options on this dialog box to hide regions in 
a subject’s sample file from alignment if these regions could potentially reveal personal 
health information (PHI) about the subject. See “Masking personal health information (PHI) 
for a subject” on page 61.

Masking personal health information (PHI) for a subject

When carrying out a forensic analysis, a lab technician must remain aware of the potential of 
exposing personal health information (PHI) about a subject that is not relevant to the 
investigation. For example, the alignment results could reveal that a subject is a carrier for a 
an inherited disease such as Leigh’s syndrome. To prevent this, you can hide regions from 
the alignment that could reveal PHI. You can elect to load default hidden regions, which 
hides the PHI regions that MITOMAP has identified, and/or hide the PHI regions that you 
explicitly define in a BED file.

No confirmation message is displayed before you remove a 
region, so be cautious when doing so.

If Strict Sort Paired Reads is selected, then with paired reads, the start and end 
points for a paired read must match to the start and end points of the amplicon for 
the read to be assigned to the amplicon. In the event that a forward read that 
matches to Amplicon #1 extends into the reverse read that matches to Amplicon 
#2, this allows the assignment of the read to only one amplicon.

You can specify which personal health information to mask for a subject only 
before carrying out the corresponding mtDNA alignment project.
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For a default or custom hidden region, the following is applicable:

• Nucleotides that are in the region are not displayed in the Pile-Up pane in the 
GeneMarkerHTS Viewer.

• The CIGAR string is hidden in the tooltip for a read in the Pile-Up pane.

• You cannot copy sequences for reads that cross the region.

• Allele counts are hidden from all reports.

• No variants are called within the region.

1. On the New Project dialog box, click PHI Settings.

The PHI Settings dialog box opens. 

Figure 2-8:  PHI Settings dialog box

2. Do one or both of the following:

For detailed information about the format for a BED file, see “BED file” on page 
161. 

Option Description
Hide the PHI regions that MITOMAP has 
identified

Click Load Default Regions.

Note: For a list of the MITOMAP locations that are the 
built in to PHI, see the following:

• http://www.mitomap.org/foswiki/bin/view/MITOMAP/
MutationsRNA 

• http://www.mitomap.org/foswiki/bin/view/MITOMAP/
MutationsCodingControl 

Hide the PHI regions that you have 
identified

Click Load BED File to open the Open BED File dialog 
box, and then browse to and select the appropriate BED 
file.

http://www.mitomap.org/foswiki/bin/view/MITOMAP/MutationsRNA
http://www.mitomap.org/foswiki/bin/view/MITOMAP/MutationsRNA
http://www.mitomap.org/foswiki/bin/view/MITOMAP/MutationsCodingControl
http://www.mitomap.org/foswiki/bin/view/MITOMAP/MutationsCodingControl
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3. Optionally, after you have loaded the default and/or custom regions that are to be 
hidden, do any or all of the following as needed:

4. Click OK.

The PHI Settings dialog box closes. The New Project dialog box remains open. The 
selected regions will be hidden from alignment.

5. Continue with setting up the new project.

Option Description
Manually add a region

Note: You can manually add as many 
regions as needed. You can add 
only a single region at a time.

Click Add.
A new region is added. As you add a new region, it is 
numbered sequentially. By default, the chromosome is 
set to M, and the Start and End positions are both set 
to “1,” but you can edit any or all of these values as 
needed.

Figure 2-9:  Manually added PHI region

Remove one region at a time Select the region, and then click Remove. After you 
remove a region, the remaining regions are 
automatically re-numbered.

Warning: No confirmation message is displayed 
before you remove a region, so be cautious 
when doing so.

Remove all regions in a single step Click Remove All.
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Working with a GeneMarkerHTS Project
The New Project dialog box provides all the options for adding a new project in 
GeneMarkerHTS. You can also open and work with existing projects in GeneMarkerHTS. 
See:

• “New GeneMarkerHTS project caveats” below.

• “To add a new GeneMarkerHTS project” on page 65.

• “To work with an existing GeneMarkerHTS project” on page 68.

New GeneMarkerHTS project caveats
• Every GeneMarkerHTS project is named project.pjt, and the project file as well as all the 

project output files are saved in a folder that, by default, is named as:

<project creation date>T<project run time_v<GeneMarkerHTS version>+<f<n>).ci

where:

• The date is in the following format: year_month_day.

• The time is in 24-hour time. 

• The software version is three digit showing the major release, the minor release, and 
the point release.

• f<n> is developer-specific information that is used for debugging purposes.

For example, a project folder named 2023_09_12_T14-28_v2.6.0+ f07776306.ci 
indicates a project that was run on October 09, 2023 at 2:18 pm in the afternoon using 
version 2.0.6 of GeneMarkerHTS. This default naming convention allows you to save 
multiple projects in the same folder without overwriting an existing project.

• If you do not specify a folder in which to save the project, then GeneMarkerHTS informs 
you that the project folder was not set, and asks you if you want to use the default project 
folder, which is the folder that contains the project sample files. 

Figure 2-10:  Create Path prompt

• The default reference that is supplied in GeneMarkerHTS is the revised Cambridge 
Reference Sequence (rCRS). If you select a different reference, then it must be in either 
FASTA or GBK format.

• When you add a new project in GeneMarkerHTS, the sample files that you load must be 
in one of three formats: compressed FASTQ files (fastq.qz), uncompressed FASTQ files 
(.fastq), or BAM files (.BAM). 
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• The Name of each sample file and the names of all the corresponding output files for a 
project are automatically generated from the names of the added sample files. You can 
edit the Name for a sample file.

• GeneMarkerHTS automatically groups paired reads in a sample, but you can split a group 
of paired reads into individual samples. 

• GeneMarkerHTS automatically adjusts the default values for both Identity and Soft 
Clipping based on the sequencer that you select. If you change the value for either one 
or both settings, then GeneMarkerHTS automatically selects “Other” for Sequencer, and 
you cannot select a different Sequencer value.

• Filter settings and table settings control the criteria for variant calling and for displaying 
project information in the Variants table in the Mito Alignment Viewer. Filter settings 
determine the alleles that are called for a project in the STR Analysis Viewer. You can 
adjust filter settings and table settings before or after alignment of the samples in a 
project.

• Amplicon settings define the amplicon-sequenced regions that were used for the mtDNA 
alignment project. You can adjust amplicon settings only before the alignment of the 
samples in a project.

• PHI settings control which personal health information to mask for a subject. You can 
adjust PHI settings only before the alignment of the samples in a project.

To add a new GeneMarkerHTS project
1. On the GeneMarkerHTS main window, click New.

The New Project dialog box opens. If this is the first project that is being run for the 
GeneMarkerHTS instance, then all the project settings are set to their default values; 
otherwise, by default, GeneMarkerHTS remembers the settings for the last run project.

Figure 2-11:  New Project dialog box
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2. Optionally, if applicable, to reset all project settings to their default values, click Reset 
Settings, and then click Yes in the Reset Settings dialog box that opens.

3. Do one of the following to specify the location in which to save the project:

• Leave the Project Folder blank, and then, by default, after you add the project 
sample files, the project folder is set to the same folder as the project sample files. 

• Next to the Project Folder field, click the Browse button to open the Project Save 
Location dialog box, and then browse to and select where the project (*.pjt) file is to 
be stored.

• In the Project Folder field, manually enter the full path to the folder in which the 
project is to be saved. 

4. If the project is to use the default reference that is supplied with GeneMarkerHTS, then 
select Use Default Reference; otherwise, leave Use Default Reference blank, and then 
next to the Reference Filename field, click the Browse button to open the Open 
Reference dialog box, and then browse to and select the reference that the project is to 
use. 

5. If the project is to use the built-in motif that is supplied with GeneMarkerHTS, then leave 
Use Default Motif selected; otherwise, to use a custom motif, clear Use Default Motif, 
and the do one of the following:

• To use the default motif as your starting point for creating a custom motif:

a. Clear Use Default Motif.

b. Continue to “To create or edit a custom motif” on page 54.

• To use an existing custom motif as your starting point for creating another custom 
motif:

a. Clear Use Default Motif.

b. Click the Browse button that is displayed to the right of the Motif Path field, and 
browse to and select the motif. 

c. Continue to “To create or edit a custom motif” on page 54. 

6. Specify all the options for the project, including the sequencer. See “New Project Dialog 
Box Settings” on page 51.

7. To add the samples for the project, click Add to open the Add Samples dialog box, and 
then select the sample files for the project.

If the specified folder does not exist, then GeneMarkerHTS prompts you to create 
the path before the project is created. 

After you add at least one sample, you can also right-click any sample and on the 
context menu that opens, click Add to add another sample.
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The sample files are added to the project and are displayed in the Sample Files pane of 
the New Project dialog box. The Name for each sample file is automatically generated 
from the name of the added file. 

8. Optionally, you can do any or all of the following for added sample files:

• To change the name of a sample file, double-click the file to select it, and then 
change the name of the file.

• To remove one or more sample files from a project, select the sample file 
(CTRL-click to select multiple files), and then click Remove. (You can also right-click 
any sample file and on the context menu that opens, click Remove.)

• To split paired read sample files into separate sample entries, right-click any one of 
the paired read sample files, and on the context menu that opens, click Split.

• To remove all sample files in a single step, click Remove All.

9. Optionally, do any or all of the following:

• To adjust the settings that affect variant calling and therefore, the variants that are 
displayed in the Variants table of the Mito Alignment Viewer, click Filter Settings to 
open the Filter Settings dialog box, and then edit any or all of the values on the Mito 
Variant tab and/or the Mito Alignment tab.

• To adjust the amplicon regions used for the alignment, click Amplicon Settings, and 
then add or remove regions as appropriate. See “Specifying amplicon regions” on 
page 59.

• To adjust the settings that mask the personal health information (PHI) for the 
subject, click PHI Settings to open the PHI Settings dialog box, and then add and/or 
remove default and/or custom hidden regions as appropriate. See “Masking 
personal health information (PHI) for a subject” on page 61.

10. Click OK.

The Project Viewer dialog box opens. The samples that are being processed for the 
project are displayed on the left side of the dialog box in the form of “Sample buttons.” 
The progress of processing a sample file is displayed on the right side of the dialog box. 
After a sample file is successfully processed for a project, the Sample button for the 
project is enabled. You can click the Sample button for any completed sample file to view 
its results in either the Mito Alignment Viewer (for an mtDNA only project) or the STR 
Analysis Viewer (for an STR analysis project), even if other sample files are being 
processed or are waiting to be processed. See Figure 2-12 on page 68.

     

To combine split paired read files, right-click any of the paired read sample files, 
and then on the context menu that opens, click Combine with <filename>.

For detailed information about filter settings for an mtDNA alignment project, see 
“Mito Alignment Viewer Filter Settings” on page 93.
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Figure 2-12:  Project Viewer dialog box with processed and unprocessed Sample files

11. Continue to Chapter 3, “GeneMarkerHTS Viewers and Reports,” on page 73. 

To work with an existing GeneMarkerHTS project
You can load a project that has been saved locally to the GeneMarkerHTS client.

1. On the GeneMarkerHTS main window, click Open.

The Open Project dialog box opens. By default, the Open Project dialog box is set to the 
directory for the project that was last opened for the GeneMarkerHTS instance. 

Figure 2-13:  Open Project dialog box

Depending on your project setup, other messages might open before the Project 
Viewer dialog box opens, such as a message about creating a non-existent project 
folder. Answer all the prompts as needed to resolve any issues and open the 
Project Viewer dialog box.

For a detailed list of the output files for a GeneMarkerHTS project, see 
“GeneMarkerHTS Project Output Files” on page 70.

Remember, a GeneMarkerHTS project is named project.pjt and if you accepted 
the default project location when creating the project, the project file is located in 
the same directory as the project sample files.

Processed sample file. Click the 
Sample button for a processed 
sample file to open the file in the 
GeneMarkerHTS Viewer.

Not yet processed sample files.



GeneMarkerHTS User’s Manual 69

Chapter 2
GeneMarkerHTS Project Setup and Management

2. Browse to and select the project with which you are working, and then click Open.

The Project Viewer dialog box opens. All the samples that were analyzed for the project 
are listed by name on the left side of the dialog box. The status bar at the bottom of the 
dialog box is set to 100%.

Figure 2-14:  Project Viewer dialog box for a completed project

3. Do one the following:

• To open the project in a viewer, double-click a Sample button. 

• If a panel was not used for the project, then the Mito Alignment Viewer opens, 
displaying the mtDNA alignment results for the sample. You can open multiple 
individual sample files at the same time. 

• If a panel was used for the project, then the STR Analysis Viewer opens, 
displaying the STR analysis results for the sample. You can open multiple 
individual sample files at the same time. 

• To compare the results for two or more samples in a Mito Alignment project in a 
single Comparison Viewer window, click Compare to open the Select Samples 
dialog box, select the sample to compare, and then click Compare. 

For detailed information about the different project viewers that are available in 
GeneMarkerHTS, see Chapter 3, “GeneMarkerHTS Viewers and Reports,” on 
page 73.
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GeneMarkerHTS Project Output Files
The table below lists the files that are generated for any GeneMarkerHTS project. All files are 
located in the project folder.

The table below lists the files and reports that are generated for each sample in an mtDNA 
alignment project. All the files are located in the project folder.

File Description
Project Settings The settings (alignment options, motif selection, and so on) for 

the project.

Trim Primer Log Lists the read sorting results for all the amplicons.

Panel Primer Match Statistics Lists the read sorting results for all the amplicons in a tab-
separated values (*.tsv) format.

Analysis Log Contains a summary of the alignment results in a standardized 
.json format.

Paired End Merge Report Generated if Merge Pairs was selected for the project. Details 
how many reads were merged and how many reads could not be 
merged.

File Description
BAM/BAI Contains the fully detailed alignment results.

Alignment Statistic Log Contains a summary of the alignment results.

Consensus Sequence Details the consensus sequence with the major alleles in FASTA 
format, where a major allele is defined as the allele with the 
highest frequency at a given position. All major alleles are 
reported unless the allele is the same as the reference. 

Consensus Statistics Lists the number of reads with each allele at each position in the 
sample.

Major Allele Report Variant report for all major alleles. 

Note: You can copy and paste a major allele string into EMPOP. 

Minor Allele Report Variant report for all minor alleles, where a minor allele is defined 
as any other allele with a frequency that is less than the allele 
with the highest frequency at a given position.

Note: You can copy and paste a minor allele string into EMPOP. 

Low Coverage Report Lists all the regions with coverages that fell below the Total 
Coverage threshold that was specified for the project.

Motif Lists all the motifs that were used for the project.

Amplicon Lists all the amplicon regions that were used for the project 
along with the number of reads (forward, reverse, and total) per 
region.
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Variants A text file saved as <Sample Name>_variants.txt. The file details 
all the EMPOP variants for the project sample: Major, Minor, and 
Combined.

Note: You can copy the variants that are detailed in this file and 
paste them into EMPOP to obtain the statistical 
information for the variants. An EMPOP direction option 
is also available on the main menu for the Mito Alignment 
viewer. See “Mito Alignment viewer main menu” on page 
76. 

File Description
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Three viewers are available in GeneMarkerHTS application for viewing the results of a 
project: the Mito Alignment viewer, the STR Analysis viewer, and the Comparison viewer.

• The Mito Alignment viewer is a viewing and editing tool that you use to view and edit the 
results of your mtDNA alignment projects and produce a variety of interactive reports that 
summarize the alignment and other analysis information.

• The STR Analysis viewer is a viewing and editing tool that you use to view the results of 
a simultaneous analysis of autosomal- and Y-STRs along with mtDNA data for your 
project samples. 

• The Comparison viewer is an interactive viewing tool that you use to view a sample to 
sample comparison for an mtDNA project as well as a variant comparison of all the 
samples in the project at the same time. 

This chapter details these viewers as well as the reporting options that are available for an 
STR project and for an mtDNA project.

This chapter covers the following topics:

• “Mito Alignment Viewer Overview and Layout” on page 75.

• “Mito Alignment Viewer Navigation and Options” on page 85.

• “Mito Alignment Viewer Filter Settings” on page 93.

• “Mito Alignment Table Settings” on page 100.

• “Mito Alignment Viewer Reports” on page 102.

• “STR Analysis Viewer Overview and Layout” on page 106.

• “STR Analysis Viewer STR and STR Stutter Filter Settings” on page 123.

• “Comparison Viewer” on page 141.

     

Remember, you can select project samples for viewing during project processing, 
or after project processing has completed. See “Working with a GeneMarkerHTS 
Project” on page 64.
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Mito Alignment Viewer Overview and Layout
You use the Mito Alignment viewer to view the results of your mtDNA alignment projects. You 
can edit the display settings for the viewer and you can use viewer options to edit the results 
of the alignment project. You can load one or more sample files in their own Mito Alignment 
viewer windows while a project is being run, or you can load one or more sample files for a 
saved project. (See “Working with a GeneMarkerHTS Project” on page 64.) When you open 
a sample file for any project in the Mito Alignment viewer, the filter settings and table settings 
that were in place at the time that the project was saved determine the variants that were 
called and the information that is displayed in the Variants Table in the viewer, but you can 
always edit these settings as needed to better suit your working needs. See “Mito Alignment 
Viewer Filter Settings” on page 93 and “Mito Alignment Table Settings” on page 100.

• If you load multiple sample files from different projects, then each project sample opens 
in its own separate Mito Alignment viewer window, and the viewer windows are not linked. 
You can independently navigate and edit the display settings for each sample file in its 
own viewer window. 

• If you load multiple sample files from the same project, then each project sample opens 
in its own separate Mito Alignment viewer window, but the viewer windows are linked. All 
the viewer windows zoom and scroll horizontally across the reference in unison. Any 
changes that you make to the filter settings for one viewer window are applied to all 
opened viewer windows for the project’s sample files.

Figure 3-1:  Mito Alignment viewer
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From top to bottom, the Mito Alignment viewer has six major components:

• The title bar. See “Mito Alignment viewer title bar” on page 76.

• The main menu. See “Mito Alignment viewer main menu” below.

• The Global View pane. “Global Viewer pane” on page 78.

• The Panes display. See “Pane displays” on page 79.

• The Variants table. See “Variants table” on page 83.

• The Status bar. See “Status Bar” on page 84.

Mito Alignment viewer title bar
The Mito Alignment viewer title bar displays the name of the sample for which you are 
reviewing the mito alignment results.

Figure 3-2:  Mito Alignment viewer title bar

Mito Alignment viewer main menu
The Mito Alignment viewer main menu is set up in a standard Windows menu format with 
menu commands grouped into menus across the menu bar.

Menu Option Description
Reports Generate one of three reports for the project: the Coverage report, the 

Template Length report, or the Read Length report. See “Mito Alignment 
Viewer Reports” on page 102.

Filter Settings Opens the Filter Settings dialog box, which contains options for changing the 
viewer display. See “Mito Alignment Viewer Filter Settings” on page 93.

Load Report Opens the Load Report dialog box, in which you can select a sample report for 
display in the viewer. See “To save/load reports for an mtDNA project” on page 
90.

Save BAM Edits If you have made any edits to a BAM project file, then you can save the edited 
BAM file as a new BAM file.

Save Report Opens the Save Report dialog box, in which you specify a folder for saving the 
information that is currently displayed in the Variants table as a report. See “To 
save/load reports for an mtDNA project” on page 90.

Table Settings Opens the Table Settings dialog box, which lists all the data columns that are 
currently displayed in the Variants table of the Mito Alignment viewer. By 
default, all available columns are initially displayed in the Variants table. To 
remove a column from the Variants table display, clear its selection. To add a 
column to the display, select it. See “Mito Alignment Viewer Filter Settings” on 
page 93.

Toggle Table Toggles the display (On or Off) of the Variants table in the Mito Alignment 
viewer. See “Variants table” on page 83.

Export to vcf Exports all the variants that are displayed in the Pile-up pane to a .vcf file. By 
default, the .vcf file is named as <sample file name>.vcf and the file is saved in 
the project folder, but you can edit one or both these values.
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View on EMPOP Database dialog box

By default, when the View on EMPOP Database dialog box first opens, all the sample 
variants that are classified as Major in the EMPOP database are displayed first. 

Figure 3-3:  View on EMPOP Database dialog box

Do any of the following:

• To view only the sample variants classified as Minor on EMPOP, select Minor.

• To view the variants of both classifications at the same time, select Combined. 

Major variants are listed first, separated by commas. Minor variants are listed second, 
separated by commas. A semi-colon delineates the major variants from the minor 
variants.

Figure 3-4:  Viewing combined sample variants 

• Copy to clipboard: Copies the currently displayed variant list to the GeneMarkerHTS 
client clipboard. You can then paste the list into third-party software such as Microsoft 
Excel.

• Open EMPOP Query: Opens an EMPOP online haplotype query form.

EMPOP Opens the View on EMOP Database dialog box, which lists all the called 
sample variants for the project by their classification (Major or Minor) on the 
EMPOP database. See “View on EMPOP Database dialog box” below.

Note: Internet access is required for this option.

Menu Option Description
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Global Viewer pane
The Global Viewer pane for the Mito Alignment viewer shows the coverage depth for the 
sample. By default, the forward read coverage is displayed in blue and the reverse read 
coverage in red. A solid black line/hollow black rectangle indicates the pile-up range. By 
default, green lines indicate the locations of major variants and orange lines indicate the 
locations of minor variants. 

Figure 3-5:  Global Viewer pane

By default, gray shading indicates areas of coverage that fall below the Total Coverage 
threshold that was specified for the filter settings for the project.

Figure 3-6:  Shading alerts for low coverage regions in the Global View pane

To zoom the display of the Global Viewer pane to only that for the pile-up region, select 
Zoom Global.

Figure 3-7:  Zoom Global selected

The following options are available for the Global Viewer pane. You can:

• Save the Global Viewer pane display as an image. See “To save the Global Viewer pane 
display as an image” on page 79.

• Change the default display colors. See “To edit the Global Viewer pane colors” on page 
157.

The zoom level for the Pile-Up pane determines the appearance of the line/
rectangle indicator in the Global Viewer pane. You can change all the default 
display colors for the Global Viewer pane. See “Configuring GeneMarkerHTS 
Visuals Settings” on page 152.

For detailed information about the Total Coverage threshold, see “To specify the 
variant call settings for an mtDNA project” on page 93.“N” is displayed for the 
consensus sequence in these areas of low coverage in the Consensus Sequence 
pane. See “Reference pane” on page 80.

For information about the Blocks option and the Variants option, see “Pile-Up 
pane” on page 82. 
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To save the Global Viewer pane display as an image

You can save the Global Viewer pane display as image with forward coverage stacked on 
top of reverse coverage. By default, the image is saved in two different formats (PNG/JPEG) 
in the project folder, but you can always select a different location. You must name the image 
when you save it.

1. Right-click in the Global Viewer pane, and on the context menu that opens, click Save 
Global Coverage Image. 

The Global Coverage Graph dialog box opens. The default location is set to the project 
folder.

Figure 3-8:  Global Coverage Graph dialog box

2. Enter a name for the image file.

3. Optionally, select a different location than the project folder for saving the file.

4. Click Save.

The Global Coverage dialog box closes. The Mito Alignment viewer remains open.

Pane displays
The Panes display for the Mito Alignment viewer consists of up to four separate panes. 
Reference Position numbers are displayed at the top of the Panes display. By definition, an 
mtDNA reference is circular, and this is reflected in the reference position numbers. As you 
scroll horizontally through a pane display, the position numbers increase up to the end 
position of the reference, and then the reference position numbering starts over again. 

Figure 3-9:  Circular reference reflected in reference position numbering in Panes display

For information about horizontally scrolling the display in the Mito Alignment 
viewer, see “Mito Alignment Viewer Navigation and Options” on page 85.
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From top to bottom, the four panes in the Panes display are the following:

• The Reference pane. See “Reference pane” below.

• The Consensus pane. See “Consensus pane” below.

• The Motifs and Amplicons pane. See “Motifs and Amplicons pane” on page 81.

• The Pile-Up pane. See “Pile-Up pane” on page 82.

Reference pane

The Reference pane displays the sequence of the reference to which the samples were 
aligned. To maintain position numbering in an mtDNA alignment project, an “N” is sometimes 
used instead of a nucleotide read in the Reference sequence. Variant calls are not reported 
for reference positions with an “N.” 

Figure 3-10:  “N” for a reference position to maintain position numbering

Consensus pane

The Consensus pane displays the consensus sequence for the major alleles, where a major 
allele is defined as the allele with the highest frequency at a given position. If any areas of 
coverage fall below the Total Coverage threshold that was specified for the project filter 
settings, then the consensus sequence is set to “N” for these regions in the pane. 

Figure 3-11:  Low coverage regions in the Consensus Sequence pane

For detailed information about the Total Coverage threshold, see “To specify the 
variant call settings for an mtDNA project” on page 93. The corresponding areas 
of low coverage are highlighted in gray in the Global Viewer pane. See “Global 
Viewer pane” on page 78.

Position 3107 in the rCRS has an “N” to maintain position numbering. Bases that are aligned at this position are 
ignored.
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You can right-click anywhere in the Consensus pane to open a context menu with two 
options for copying the consensus sequence.

• Copy Consensus. Opens the Copy Consensus dialog box. The dialog box displays the 
start and end positions for the portion of the consensus sequence that is currently 
displayed in the Consensus pane. 

Figure 3-12:  Copy Consensus dialog box

The following options are available for the Copy Consensus dialog box:

• You can leave the Start and End positions as-is, or you can manually edit the values.

• You can copy the consensus sequence bases as displayed (G, A, etc.) or you can 
select Use IUPAC to copy the consensus sequence in its IUAPC nomenclature code 
instead.

• You can select Copy to copy the designated region for the sequence (start and end 
positions are included) to the client clipboard, or you can click Copy All to copy the 
entire consensus sequence, regardless of the Start and End positions that are 
indicated, to the client clipboard. You can now paste the copied information into a 
third-party application such as Microsoft Excel.

• Copy Entire Consensus. Copies the entire consensus sequence to the client clipboard. 
You can now paste the copied information into a third-party application such as Microsoft 
Excel.

Motifs and Amplicons pane

The Motifs and Amplicons pane is displayed only if one or both of the following variables 
were used for the project:

• A motif was used for the project. The pane displays the motif regions (green) that were 
used for the mtDNA alignment project. If you hold your mouse pointer for a motif region, 
a tooltip opens that displays the following information: the start and end points for the 
motif region and the variant calls in the region. 

• Amplicon settings were specified for the project. The pane displays the 
amplicon-sequenced regions (blue) that were used for the mtDNA alignment project, 
whether a panel was used or not. If you hold your mouse pointer over an amplicon region, 
a tooltip opens that displays the following information: the chromosome, the chromosome 
start and end positions, and the number of reads that were assigned to the region.

See Figure 3-13 on page 82.
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Figure 3-13:  Motifs and Amplicons pane

Pile-Up pane

Unlike the other panes in the Mito Alignment viewer Panes display, the Pile-Up pane is not 
explicitly identified by name in the viewer; however, it is always located as the last pane in 
the display. The pane displays a view of all the reads for the sample as they align to the 
reference sequence. Greater Than and Less Than symbols point to the 5’ end of the read, 
where the Greater Than (>) symbol is used for forward reads and the Less Than (<) symbol 
is used for reverse reads. 

Figure 3-14:  Variants selected for Pane displays

Two options that are displayed next to the Global Viewer pane are available for changing the 
Pile-up pane display:

• Blocks – If Blocks is selected, then the background for each nucleotide is a color and the 
nucleotide (A, T, C, and G) is white.

Figure 3-15:  Blocks selected for Pile-up pane display

     

Greater Than and Less Than symbols Highlighted variant nucleotide
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• Variants – Selected by default. If Variants is selected, then for all non-variant nucleotides, 
the background is white and the nucleotide (A, T, C, and G) is displayed in color. For 
variant nucleotides, the background is colored, and the nucleotide is displayed in white, 
which is referred to as a highlighted variant. 

Figure 3-16:  Variants selected for Pile-up pane display

Figure 3-17:  Blocks and Variants selected for Pile-up pane display

Variants table
By default, the Variants table for the Mito Alignment viewer lists each variant call in 
increasing order of their sequence position, where:

• A major allele is defined as the allele with the highest frequency at a given position. 

• All major alleles are reported unless the allele is the same as the reference. 

• Minor alleles are any other allele at a given position with a frequency that is greater than 
the Sequence IT Count (the minimum threshold for a sequence to be flagged as a 
possible allele).

• Insertions are reported as major alleles if they occur at a frequency that is greater than or 
equal to 50% and as minor alleles if they occur at a frequency that is less than 50%.

• Because reference alleles can represent a secondary mutation of a major allele, 
reference alleles are reported as minor alleles if their frequencies occur at a rate that is 
greater than the minimum threshold for Allele Frequency.

     

You can select both Blocks and Variants for the Pile-up pane display. In this case, 
all nucleotides are still displayed in white on a colored background; however, all 
nucleotides other than variant nucleotides are dimmed and all variant nucleotides 
are highlighted to visually differentiate them from non-variant nucleotides. See 
Figure 3-17 below.To edit the background colors, highlighting colors, nucleotide 
colors, and the nucleotide visibility for the Pile-up pane display, see “To edit the 
background and highlighting colors in the  Pile-up pane display” on page 154 and 
“To edit the visibility and default nucleotide colors for the Pile-up pane display” on 
page 155.

Highlighted variant

Variant nucleotide remains highlighted.
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Also by default, the Variants table shows both (major and minor) allele types, but the 
following options are available:

• You can choose to show only major alleles or only minor alleles. 

• The specific alleles and the information that is displayed for the alleles in the Variants 
table are determined by the filter settings and table settings that were in place at the time 
that the project was saved, but you can always edit these settings after the project is 
completed. “Mito Alignment Viewer Filter Settings” on page 93. 

• You can click a column header to change the default sort order of the data. An icon in the 
column header indicates the sort direction. An Up arrow indicates an ascending sort and 
a Down arrow indicates a descending sort. 

Figure 3-18:  Variants table

Status Bar
After the Mito Alignment viewer opens, a temporary status bar is displayed in the lower left 
corner of the viewer below the Variants table. The status bar displays the progress of loading 
the project in the viewer. After the project is fully loaded, the status bar briefly displays 100%, 
and then it is closed and is no longer displayed in the viewer.

Figure 3-19:  Status bar

You must wait until after the status for loading a project is 100% and the status bar 
closes before you can work with the project in the Mito Alignment viewer.

Indicates the type of allele to display in the Variants table
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Mito Alignment Viewer Navigation and Options
You can easily navigate the Mito Alignment viewer using your mouse as well as some 
keyboard hotkeys. In the Global Viewer pane, the Pile-up pane, and the Variants table, you 
can use the mouse as well as some keyboard hotkeys to navigate the viewer display. In the 
Pile-up pane and the Variants table, you can also right-click to open a context menu that 
contains a list of options for working with and editing the project variant information. See:

• “Mito Alignment viewer navigation” below.

• “Mito Alignment viewer variant-specific viewing and editing options” on page 86.

Mito Alignment viewer navigation
You can easily navigate the Mito Alignment viewer using your mouse as well as some 
keyboard hotkeys in the Global Viewer pane, the Pile-up pane, and the Variants table. 

Option Description
Global Viewer pane
Double-click any region in the Global Viewer pane to move the Panes display to the same area.

Pile-up pane display: When the Mito Alignment viewer first opens, the starting position for the 
Pile-Up pane is the first reference nucleotide position (Pos #1). Any of the following actions that you 
carry out for the Pile-up pane results in an automatic adjustment of the displays for the Reference 
pane, the Consensus pane, and the Motifs/Amplicon pane.

Zoom In Two options are available:
• Hold down the left mouse button and draw a box from the upper left 

hand corner of the pane towards the lower right hand corner. A box 
is formed around the area that being reduced for viewing.

• Hold down the CRTL key, and then roll the scroll wheel up on the 
client mouse.

Zoom Out Two options are available:
• Hold down the left mouse button and draw a box from the lower 

right hand corner of the pane towards the upper left hand corner.
• Hold down the CRTL key, and then roll the scroll wheel down on the 

client mouse.

Note: The magnification for zooming out is always 100%.

Horizontal Scroll Hold down the right mouse button and then drag the cursor across the 
display from left to right, or right to left.

Vertical Scroll Use the Vertical Scroll bar to the right of the Panes display, or use the 
Scroll wheel on your mouse.

Moving to each variant 
position in the pane

You can click the Pile-up pane, and then use the following keyboard 
shortcuts to move the display to each variant position:
• CTRL + f moves the display forward one variant position at a time.
• CTRL +b moves the display backward one variant position at a 

time.
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Mito Alignment viewer variant-specific viewing and editing 
options
Options are available in both the Pile-up pane and the Variants table for viewing and editing 
variant-specific information. Some of these options require you to use your mouse and some 
keyboard hotkeys, while other options require you to right-click to open a context menu that 
has the options. 

Moving up and down in 
the pane

You can click in the Pile-up pane, and in lieu of using the scrollbar that 
is displayed at the far right side of the pane, you can use the following 
keyboard shortcuts to move up and down in the pane:
• CTRL + d moves the pane display down.
• CTRL + u moves the pane display up.

Move to a closest variant 
position in the Variants 
table

Right-click any position in the Pile-Up pane and on the context menu 
that opens, click Go to closest position in table. The variant that is 
closest to the selected position is highlighted in the Variants table.

Variants table
Double-click any entry in the Variants table to move the Pile-up pane display to the corresponding 
variant position.

Option Description
Pile-up pane
Open a tooltip with the following 
information for a specific read (variant 
or non-variant):
• Read name
• Read direction
• Read CIGAR string
• Read Tags

SHIFT + click the mouse scroll wheel, or CTRL +SHIFT, 
and then left mouse click.

Figure 3-20:  Read tooltip

Open a tooltip with the following 
information for a specific variant:
• The position number for the allele
• The major allele at the position
• The read direction for the allele
• The counts for the different alleles 

at the position
• The total coverage for the position
• The Allele Balance Ratio
• The Allele Balance Score

Click the mouse scroll wheel or CTRL + left mouse click.

Figure 3-21:  Variant tooltip

Add variant at position <n> See “To add a variant at a given position” on page 89.

Option Description
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Jump to position Note: Jump to position moves the Pile-up pane left or 
right—you are moving the display to a particular 
variant position.The Reference position, therefore, 
changes accordingly in the Reference pane.

Right-click any position, and on the context menu that 
opens, click Jump to Position. In the Position Input dialog 
box that opens, enter the position number to move the 
viewer to. The position is displayed in the middle of the 
viewer.

Figure 3-22:  Position Input dialog box

Jump to line Note: Jump to line moves the Pile-up pane up and 
down—you are moving the display to a particular 
read.The Reference position, therefore, does not 
change in Reference pane.

Right-click any position, and on the context menu that 
opens, click Jump to line. In the Position Input dialog box 
that opens, enter the line number to move the viewer to. 
The read is displayed as the top of the Pile-up pane.

Figure 3-23:  Position Input dialog box

Go to closest position in table Right-click any position, and on the context menu that 
opens, select this option to highlight the entry in the 
Variants table for the variant that is closest to this selected 
position.

Copy Read’s Sequence To copy the sequence from any read to your clipboard, 
right-click any read, and on the context menu that opens, 
click Copy Read’s Sequence. You can then use standard 
Paste commands to paste the copied information into a 
third-party product such as Microsoft Word or Notepad.

Option Description
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Figure 3-24:  Called variants in a removed read

     

Remove Read/Undo Remove Read Right-click any position, and on the context menu that 
opens, select this option to remove the read from any 
consideration when analyzing or graphing the project 
results. A solid horizontal black line is displayed across 
the read to indicate that it has been removed. See Figure 
3-24 below.
To add a removed read back, right-click the read, and on 
the context menu that opens, click Undo Remove Read. 

Note: If the removed read contains any called variants, 
then these variants are highlighted in light blue in 
the Variants table. See “Variants table” on page 
83.

Variants table
Copy selected Click and hold the left mouse button and then draw a box 

(square or rectangle) around the cells that are being 
copied. Right-click any of the copied cells, and on the 
context menu that opens, select Copy selected to copy 
the selected table cells to your clipboard. Use standard 
keyboard commands or menu commands to paste the 
copied cells into a third-party application such as 
Microsoft Word or Excel.

Deleting a variant See “To delete a variant at a given position” on page 89.

Saving/Loading reports See “To save/load reports for an mtDNA project” on page 
90.

Option Description

Removed 
read

Called variants in removed read
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To add a variant at a given position

You can manually add a variant (insertion or deletion) at a position of your choice in the 
Pile-Up pane. 

1. In the Pile-Up pane, right-click the position at which you are adding the variant.

A context menu opens with various options, including options for adding a variant.

2. Click Add Variant at position <n>.

A second context menu opens with different options for adding a variant at the given 
position, such as Add A or Add del. 

Figure 3-25:  Pile-up context menu, Add variant at position <n> options

3. On the second context menu, select an Add variant at position option.

The context menu closes and Comment Input dialog box opens. 

Figure 3-26:  Comment Input dialog box

4. Optionally, enter the comment that is to be stored for the indicated position, and then 
click OK.

The Comment Input dialog box closes. A new entry that is highlighted in green is 
displayed for the added variant in the Variants table. 

Figure 3-27:  New variant entry in Variants table

To delete a variant at a given position

You can manually delete a variant (insertion or deletion) from a project in the Variants table. 

1. In the Variants table, right-click the variant that you are deleting.

A context menu opens with three options: Remove <variant> at position < >, Copy 
Selected, and Jump to next variant-containing line. See Figure 3-28 on page 90.



90 GeneMarkerHTS User’s Manual

Chapter 3
GeneMarkerHTS Viewers and Reports

Figure 3-28:  Variants table context menu

2. Select Remove <variant> at position < >.

The context menu closes and Comment Input dialog box opens. 

Figure 3-29:  Comment Input dialog box

3. Optionally, enter the comment that is to be stored for the indicated position, and then 
click OK.

The Comment Input dialog box closes. The variant remains displayed in the table, but it 
is now highlighted in red and the Category is set to removed.

Figure 3-30:  New variant entry in Variants table

To save/load reports for an mtDNA project

After you generate an mtDNA project for the first time, the project settings (filter settings and 
table settings) are saved as Initial_Report at the Project Folder level. After you make any 
changes to the project settings and/or any manual edits to the project (for example, adding or 
deleting a variant), you can save these changes as another project report. Each report that 
you save is saved in a separate sub-folder under the primary project folder with a Change 
Log file that details the changes made to the project settings and project results. With a 
project opened in the Mito Alignment viewer, you can load any report that has been saved for 
the project to immediately update the information that is displayed for the project in the 
viewer. See:

• “To save a report for an mtDNA project” below.

• “To load a report for an mtDNA project” on page 91.

To save a report for an mtDNA project
1. Do any or all of the following as needed:

• On the Mito Alignment viewer main menu, click Filter Settings to open the Filter 
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Settings dialog box, make any needed edits to the settings, and then click OK to 
save the edited settings. See “Mito Alignment Viewer Filter Settings” on page 93.

• On the Mito Alignment viewer main menu, click Table Settings to open the Table 
Settings dialog box, make any needed edits to the settings, and then click OK to 
save the edited settings. See “Mito Alignment Table Settings” on page 100.

• In the Pile-Up pane, remove a read, undo a removed read, add one or more 
variants, or do any combination of these three options. See “Remove Read/Undo 
Remove Read” on page 88 or “To add a variant at a given position” on page 89.

• In the Variants table, delete one or more variants. See “To delete a variant at a given 
position” on page 89.

2. On the Mito Alignment viewer main menu, click Save Report.

The Save Report dialog box opens.

Figure 3-31:  Save Report dialog box

3. Enter a name for the sub-folder in which to save the report, and then click OK.

The Save Report dialog box closes. The report is saved in a separate sub-folder under 
the primary project folder with a Change Log file that details the changes made to the 
project results. You can now load this report for a project to immediately update the 
information that is displayed for the project in the viewer. 

Figure 3-32:  Saved Project report and folder structure

To load a report for an mtDNA project
1. On the Mito Alignment viewer main menu, click Load Report.

The Load Report dialog box opens. The location is initially set to Initial_Report. 
(Remember, this is the report that is automatically generated and saved after you run an 
mtDNA project for the first time.)

Figure 3-33:  Load Report dialog box

The sub-folder name cannot contain any spaces or special characters. 
Underscores (_) are allowed.
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2. On the Load from folder drop-down list, leave Initial_Report selected, or select another 
folder that contains a secondary report for loading.

3. Click OK.

The Load Report dialog box closes, and a second dialog box, Loading, briefly opens and 
then closes as the selected report is loaded for the project. After the selected report is 
successfully loaded, the information that is displayed for the project is immediately 
updated in the Mito Alignment viewer.
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Mito Alignment Viewer Filter Settings
Filter settings define the parameters for including a read in or excluding a read from an 
mtDNA analysis. When you open a sample in the Mito Alignment viewer, the filter settings 
that were in place at the time that the project was saved determine the results that are 
displayed in the Global Viewer and the Pane displays for the Mito Alignment viewer, but you 
can edit these settings to better suit your working requirements. You specify the variant call 
filter settings on the Mito Variant tab on the Filter Settings dialog box and you specify the 
reference region filter settings on the Mito Alignment tab. Four options are available for 
specifying the filter settings for an mtDNA project.

• You can apply the default filter settings as-is.

• You can edit the default values for the filter settings, and then apply the settings.

• You can load previously saved filter settings, and then apply the settings as-is.

• You can load previously saved filter settings, edit any of the values, and then apply the 
settings.

See: 

• “To specify the variant call settings for an mtDNA project” below.

• “To set the reference region settings for an mtDNA project” on page 97.

To specify the variant call settings for an mtDNA project
1. On the Mito Alignment viewer main menu, click Filter Settings.

The Filter Settings dialog box opens. The Mito Alignment tab is the open tab.

2. Open the Mito Variant tab

Figure 3-34:  Filter Settings dialog box, Mito Variant tab

Table settings define the information that is shown and the information that is 
hidden for a called variant in the Variants table in the Mito Alignment viewer. See 
“Mito Alignment Table Settings” on page 100.
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3. Do one of the following three options:

• Review the default settings, and if you are satisfied that the Mito Variant filter 
settings are correct as-is for your project, then go to Step 4.

• Edit any of the default values for the Mito Variant filter settings. See Table 3-1 below.

• Click Load to open the Load Filter Settings dialog box, and then browse to and 
select a Filter Settings (.settings) file. 

Both Mito tabs are populated with the values in the settings file. You can leave the 
values as-is on the Mito Variant tab, or you can edit any of the values before you 
apply the settings. See Table 3-1 below.

Figure 3-35:  Load Filter Settings dialog box

If you edit any of the default values for the Mito Variant filter settings, you can click 
Default, and then click Yes in the Default values message that opens and all 
values are immediately reset to their default values.

Table 3-1: Filter Settings dialog box, Mito Variant tab

Option Description
Variant Percentage The percent of reads that must contain the variant for the variant to be 

called at the indicated position.

Variant Allele Coverage The total number of reads that must contain the variant at the indicated 
position for the variant to be called.

Total Coverage The total number of reads that must occur at the indicated position for 
the variant to be called.

Allele Score Difference A value that is calculated for each minor allele to determine if the allele 
is a true variant and therefore, is to be included in the analysis results, 
or if the allele is a false positive and therefore, is to be filtered from the 
results. See “Allele Score Difference” on page 95.

Allele Balance Ratio A value that is calculated for each allele to determine if the allele is a 
true variant and therefore, is to be included in the analysis results, or if 
the allele is a false positive and therefore, is to be filtered from the 
results. See “Allele Balance Ratio” on page 96.

SNP. Default value is < 2.5.

Indel. Default value is < 5.0.
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4. If you must change the reference region for the analysis, then go to “To set the reference 
region settings for an mtDNA project” on page 97; otherwise, do one of the following:

• Click OK to close the Filter Settings dialog box and immediately update the Mito 
Alignment viewer display based on the settings.

• If you edited any of the filter settings and want to save these edits before applying 
them, then click Save to open the Save Filter Settings dialog box and save the filter 
settings to a Filter Settings (.settings) file. 

Figure 3-36:  Save Filter Settings dialog box

Note the following about saving a Filter Settings file:

• You must enter a name for the file. 

• The file type is Filter Settings File (.settings) and you cannot change this. 

• The default location for saving the Filter Settings file is the project folder, but you 
can always select a different location.

• You cannot save individual filter settings files for the Mito Variant Tab and the 
Mito Alignment tab. All settings on both Mito tabs are saved when you save a 
filter settings file for an mtDNA project.

After you save the filter settings file, you can click OK to close the Filter Settings 
dialog box and immediately update the Mito Alignment viewer display based on the 
applied settings.

Allele Score Difference

In GeneMarkerHTS, a quality score is calculated for every SNP or insertion allele as the 
median of the base Phred quality score from the original data. Because base quality scores 
are not possible for a deletion, the quality scores for the bases that surround a deletion are 
used instead. The Allele Score Difference filter, which is based on the base quality score for 
an allele, is applied individually for each direction as follows:

• The total number of reads for the minor allele is recorded.

• The base quality score for each minor allele is subtracted from the base quality score for 
the major allele to calculate the Allele Score Difference.
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If the both of the following criteria are met, then the variant is assumed to be a false positive 
and the minor allele is filtered from the alignment results:

• The Allele Score Difference is greater than its set threshold.

• The total number of reads for the minor allele is greater than or equal to five.

If either of these criteria are not met, then the allele is assumed to be a true allele and it is not 
filtered from the results. 

Allele Balance Ratio

The Allele Balance Ratio is another filter that you can use to determine if an allele is a true 
allele or a false positive. The Allele Balance ratio is defined as the maximum value for one of 
the following:

• Allele Forward %/Total Forward % or Total Forward %/Allele Forward %

• Allele Reverse %/Total Reverse % or Total Reverse %/Allele Reverse %

with different default thresholds specified for SNPs (2.5) and indels (5.0).

Consider the following scenario, where:

• Two forward reads and 79 reverse reads with the allele (a SNP), for 81 total allele reads.

• 1758 total forward reads and 6055 total reverse reads, for 7812 total reads.

This results in the following:

Although SoftGenetics has supplied the default values for the calculation of the Allele 
Balance Ratio, you can always edit one or both of these thresholds. If you edit a value, you 
must try to maintain a balance of sensitivity versus specificity. For example, if you are 
concerned that variants are being called that are actually false positives and the variants 

Value Calculation
Total Forward % 1758/7813 = 0.22501

Total Reverse % 6055/7813 = 0.77499

Allele Forward % 2/81 = 0.02469

Allele Reverse % 79/81 = 0.97531

Allele Forward %/Total Forward % 0.02469/0.22501 = 0.9113

Total Forward %/Allele Forward % 0.22501/0.02469 = 9.1134

Allele Reverse %/Total Reverse % 0.97531/0.77499 = 1.2585

Total Reverse %/Allele Reverse % 0.77499/0.97531 = 0.7946

Determination: Because 9.1134 is > 2.5, this allele is filtered from the results.

If an allele is determined to be one directional, then an Allele Balance Ratio is not 
calculated. Instead, if the allele is a major allele, then it is not filtered from the 
results.
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also appear to be unbalanced, then you might tighten the restrictions on variant calling and 
decrease the applicable threshold value. Conversely, if some expected variants are not 
being called, then you might loosen the restrictions on variant calling and increase the 
applicable threshold value.

To set the reference region settings for an mtDNA project
1. Do one of the following:

• If the Filter Settings dialog box is already open, then open the Mito Alignment tab. 
Go to Step 2.

• On the Mito Alignment viewer main menu, click Filter Settings.

The Filter Settings dialog box opens. The Mito Alignment tab is the open tab.

Figure 3-37:  Filter Settings dialog box, Mito Alignment tab

2. Do one of the following:

• Review the default settings, and if you are satisfied that the Mito Alignment filter 
settings are appropriate as-is for your project, then go to Step 3.

• Edit any of the default values for the Mito Alignment filter settings. See Table 3-2 on 
page 98.

\

• Click Load to open the Load Filter Settings dialog box, and then browse to and 
select a Filter Settings (.settings) file. See Figure 3-38 on page 98.

Both Mito tabs are populated with the values in the settings file. You can leave the 
values as-is on the Mito Alignment tab, or you can edit any of the values before you 
apply the settings. See Table 3-2 on page 98.

     

If you edit any of the default values for the Mito Variant filter settings, you can click 
Default, and then click Yes in the Default values message that opens and all 
values are immediately reset to their default values.
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Figure 3-38:  Load Filter Settings dialog box

3. Do one of the following:

• Click OK to close the Filter Settings dialog box and immediately update the Mito 
Alignment viewer display based on the applied settings.

• If you edited any of the filter settings and want to save these edits before applying 
them, then click Save to open the Save Filter Settings dialog box and save the filter 
settings to a Filter Settings (.settings) file. See Figure 3-39 on page 99.

     

Table 3-2: Filter Settings dialog box, Mito Alignment tab

Option Description
Template Length Optional. Select to filter reads for paired data. The paired read is kept if 

the read length is > (TLEN) or < - (TLEN). You can leave the default 
value set to 100, or you can edit the value.

Note: If the data is non-paired, then read length is used for filtering.

Variant Calling (You must select one option.)

• Entire Reference: The default value. Select to call variants in any 
region.

• Input Region: Select to call variants in a single specific region. If you 
select this option, then you must adjust the Start and End values.

• Input Region: Select to call variants in multiple specific regions. If you 
select this option, then you can manually adjust the Start and End 
values for each region, or you can select Load BED File, and then in 
the Load BED Settings dialog box that opens, browse to and select 
the BED file that defines these multiple regions.

Note: For detailed information about the format for a BED file, see 
“BED file” on page 161. After you load a BED file, you can use 
the Add option and the Remove or Remove All options to add 
and remove regions for the file. If you add a region, you must 
specify the Start and End positions for it. Positions in a BED file 
are inclusive, start through end.
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Figure 3-39:  Save Filter Settings dialog box

Note the following about saving a Filter Settings file:

• You must enter a name for the file. 

• The file type is Filter Settings File (.settings) and you cannot change this. 

• The default location for saving the Filter Settings file is the project folder, but you 
can always select a different location.

• You cannot save individual filter settings files for the Mito Variant tab and the 
Mito Alignment tab. All settings on both Mito tabs are saved when you save a 
filter settings file for an mtDNA project.

After you save the filter settings file, you can click OK to close the Filter Settings 
dialog box and immediately update the Mito Alignment viewer display based on the 
applied settings.
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Mito Alignment Table Settings
Table settings define the data columns that are displayed and the data columns that are not 
displayed (hidden) for a called variant in the Variants table in the Mito Alignment viewer. By 
default, all available data columns are displayed for a called variant, and the data is 
categorized as one of the following: General, Coverage, Coverage Percent, Score, or 
Modification. When you open a sample for an mtDNA project in the Mito Alignment viewer, 
the table settings that were in place at the time that the project was saved determine the data 
columns that are displayed in the Variants table, but you can always edit these settings to 
better suit your working requirements. 

To specify the table settings for an mtDNA project
1. On the Mito Alignment viewer main menu, click Table Settings.

The Table Settings dialog box opens. By default, all columns are selected for display in 
the Variants table. 

Figure 3-40:  Table Settings dialog box

2. Leave the columns that are to be displayed in the Variants table selected; otherwise, to 
hide a column from the display, clear its selection.

Filter settings define the parameters for including a read in the analysis or 
excluding a read from the analysis. See “Mito Alignment Viewer Filter Settings” on 
page 93.

Column Description
General
Index Unique system-generated identifier for the variant.

Position The nucleotide position in the chromosome where the variant occurs.

Ref The reference nucleotide at the variant position.
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3. Click OK to close the Table Settings dialog box and immediately update the display of 
the Variants table.

Alt The alternate (variant) nucleotide at the variant position.

IUPAC The IUPAC nucleotide code for the allele. If multiple alleles are called at 
a position, then the appropriate IUPAC ambiguity code is reported. 

Note: Mixtures of a deletion and other alleles use a lowercase letter.

Variants The standard variant call.

Variant % The variant frequency at the indicated position.

Coverage The total number of reads (total coverage) at the variant position.

Coverage
A #(F,R), C #(F,R), 
G #(F,R), T#(F,R)

The number of reads that show the indicated nucleotide at the variant 
location in the forward direction and the number of reads that show the 
indicated nucleotide at the variant location in the reverse direction.

Del #(F,R) The number of reads that show a deletion at the variant location in the 
forward direction and the number of reads that show a deletion at the 
variant location in the reverse direction.

Ins #(F,R) The number of reads that show an insertion at the variant location in the 
forward direction and the number of reads that show an insertion in the 
reverse direction at the variant location.

Coverage Percent
A(%), C(%), G(%), T(%) The percentage of reads that show the indicated nucleotide at the 

variant location.

Del(%) The percentage of reads that show a deletion at the variant location.

Ins(%) The percentage of reads that show an insertion at the variant location.

Score
A Score, C Score, G 
Score, T Score

The median Phred quality score for the indicated allele (SNP) in both 
the forward and reverse directions.

Modifications
Category Indicates the variant status for the project in the Variants table - Called, 

Removed, Added, 

Comment  Any comment that was entered for the added or deleted variant.

Column Description
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Mito Alignment Viewer Reports
Three reports are available from the Reports option on the Mito Alignment viewer main 
menu: 

• Coverage report. See “Coverage report” below.

• Template Length Report. See “Template Length report” on page 104.

• Read Length report. See “Read Length report” on page 105.

To generate a report, simply select the report option on the Reports menu on the Mito 
Alignment viewer. For example, to generate the Coverage report, select Reports > Coverage 
Report. After a report is generated, it is displayed in a separate window that opens on top of 
the Mito Alignment viewer. 

Coverage report
The Coverage report provides a high-level overview of the fraction of bases (the entire 
reference range, or the range of bases that was specified in the filter settings for the project) 
that have some level of coverage that is greater than or equal to the Total Coverage 
threshold that was specified for the project. The report displays the coverage distribution of 
sample reads without directional information (a solid black line) and individually for both the 
forward and reverse directions (blue and red lines, respectively). The report also details low 
coverage regions in a separate table below a Coverage Curve graph. The report is useful for 
identifying regions that were not adequately sequenced because of low coverage. 

Figure 3-41:  Coverage report
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Optionally, after you generate a Coverage report, you can do one or both of the following for 
the report:

• Change the Coverage Report display. See “To change the Coverage Report display” 
below.

• Save the low coverage regions table as a text file. See “To save the low coverage regions 
as a text file” below.

To change the Coverage Report display

1. On the Coverage report window, click Settings.

The Coverage Report Settings dialog box opens. The dialog box shows the options for 
changing the display of the report. By default, Both is selected, which results in all lines 
(non-directional (black), forward (blue), and red (reverse)) being displayed on the report. 

Figure 3-42:  Coverage Report Settings dialog box

2. Do one of the following, and then click OK to close the dialog box and immediately apply 
the changes.

• To display only the total coverage for all reads (non-directional black line), select 
Total Coverage.

• To display only the forward and reverse reads (directional blue and red lines), click 
Directional Coverage.

To save the low coverage regions as a text file

1. On the Coverage report window, click Save As.

The Save Coverage Report dialog box opens. By default, the location in which to save 
the report is set to the top-level project folder, but you an always select a different 
location. The file type is set to Coverage Report File (*.txt) and you cannot change this. 
See Figure 3-43 on page 104.

     



104 GeneMarkerHTS User’s Manual

Chapter 3
GeneMarkerHTS Viewers and Reports

Figure 3-43:  Save Coverage Report As dialog box

2. Enter a name for the report.

3. Optionally, browse to and select a different location for saving the report.

4. Click Save.

The Save Coverage Report dialog box closes. The Coverage report window remains 
opens.

Template Length report
The Template Length report shows a length distribution based on TLEN values in the BAM 
file for paired-end data. TLEN is a positive value in the BAM file for forward read data and the 
same value, but stored as a negative value, for the reverse read data. 

Figure 3-44:  Template Length report
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Read Length report
The Read Length report consists of two graphs. The Read Length (top) graph shows the 
length of the sequences in the BAM file. The Aligned Read Length (bottom) shows the length 
of the sequences, ignoring any soft-clipping in the CIGAR string. 

Figure 3-45:  Read Length report
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STR Analysis Viewer Overview and Layout
The STR Analysis viewer is an interactive view-only tool that you use to view the results of a 
simultaneous analysis of autosomal- and Y-STRs and the mitochondrial data for your project 
samples. You first use the STR Analysis viewer to view a summary of the autosomal- and 
Y-STRs analysis results for your project. If applicable, you can then open the Mito Alignment 
viewer directly from the STR Analysis viewer and view the mtDNA alignment data for the 
project. When you open a sample file for any project in the STR Analysis viewer, the filter 
settings that were in place at the time that the project was saved determine the alleles that 
were called for the project, but you can always edit these settings as needed to better suit 
your working needs. See “STR Analysis Viewer STR and STR Stutter Filter Settings” on 
page 123.

Figure 3-46:  STR Analysis viewer

The STR Analysis viewer has two distinct but interactive panes: the Histogram Viewer pane 
and the STR Results pane. By default, when the viewer first opens, the Histogram Viewer 
pane is displayed on the left and the Results Table pane is displayed on the right. Both panes 
provide a way to navigate project results with the Histogram Viewer pane providing an image 
of the project results and the STR Results pane providing a tabulated display of the project 
results. As shown in Figure 3-46 above, the pane displays are linked. If you 
double-click a histogram, then the focus in the STR Results Table pane is changed to the 
corresponding results, which are highlighted in light blue. Conversely, if you double-click any 
marker result in the STR Results Table pane, then the focus of the Histogram Viewer pane is 
set to that of the marker histogram and all the alleles for the marker are highlighted in light 
blue in the STR Results Table pane. 

From top to bottom, the STR Results Analysis viewer has five major components:

• The title bar. See “STR Analysis viewer title bar” on page 107.

• The main menu. See “STR Analysis viewer main menu” on page 107.

• The Viewer Options menu. See “Viewer Options menu” on page 110.

• The Histogram Viewer pane. See “Histogram Viewer pane” on page 110.

• The STR Results Table pane. See “STR Results Table pane” on page 114.
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STR Analysis viewer title bar
The STR Analysis viewer title bar is displayed at the top of the STR Analysis viewer. The title 
bar displays the name of the sample for which you are reviewing the STR analysis results.

Figure 3-47:  STR Analysis viewer title bar

STR Analysis viewer main menu
The STR Analysis viewer main menu is displayed below the title bar. The menu is set up in a 
standard Windows menu format with menu commands grouped into menus across the menu 
bar. Some of the menu options are available in other areas of the viewer.

Menu Option Description
File • Open Mitochondrial Alignment: Opens the Mito Alignment viewer. See “Mito 

Alignment Viewer Overview and Layout” on page 75.

• Export Table: Use this option to export the filtered STR results to a .csv file. By 
default, the file is named <sample file name>_strresults_filtered,csv,and the 
export location is the project folder, but you can edit one or both of these default 
values before you export the table.

• Export Histograms as Images: Use this option to export all the histograms in a 
single step that are displayed in the Histograms Viewer pane as .jpgs.

• Export Histograms as SVGs: Use this option to export all the histograms in a 
single step that are displayed in the Histograms Viewer pane as .svgs. 

• Export Histograms as Single PDF: Use this option to export all the histograms in 
a single step that are displayed in the Histograms pane to a single PDF file. 

Note: By default, the default export location is the project folder, but you can select a different 
folder. 

Edit Opens the Filter Settings dialog box, which contains options that affect the results 
that are displayed in the STR Results Table pane. See “STR Analysis Viewer STR 
and STR Stutter Filter Settings” on page 123.

View • Stack Pane Display: Stacks the pane display so that both panes are displayed 
horizontally in the viewer, with the Histogram Viewer pane displayed above the 
STR Results Table pane.

• Side-by-Side Pane Display: The default display. Displays the panes side by side 
in the viewer, with the Histogram Viewer pane displayed on the left and the STR 
Results Table pane displayed on the right. 

• Zoom In: Zooms in on the Histogram Viewer pane display. You can click this 
option as many times as needed to achieve a preferred zoom level, you can use 
the Zoom slider bar, or you can use the standard Windows keyboard command 
(CTRL ++).

Note: When the STR Analysis viewer first opens, the Histogram Viewer pane 
display is zoomed in at 100%.

• Zoom Out: Zooms out the Histogram Viewer pane display. You can click this 
option as many times as needed to achieve a preferred zoom level, you can use 
the Zoom slider bar, or you can use the standard Windows keyboard command 
(CTRL + -).
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STR Analysis viewer reports

Three reporting options are available under the Report menu command on the STR Analysis 
viewer main menu. If the Report option is selected for an allele in the STR Results Table 
pane, then the allele is included in the reports. By default, when you generate any STR 
Analysis viewer report, the report is named <project sample name>_<report 
option>_report.<format>, such as 2800M_ngs_str_allele_report.tsv, and the project folder is 
selected as the folder for saving the generated report. You can edit the report name, but not 
the format, and you can select a different folder in which to save the report.

• NGS STR Allele Report. The NGS STR Allele report includes the following information for 
each allele: the Marker, the Allele Name, the Bracket Sequence, the Allele Total Count, 
the User Call, and the User Comment. You can generate this report in one of two formats: 
tab-separated values (*.tsv) or .fasta format. 

Figure 3-48:  NGS STR Allele report example, *.tsv format

• Clear Marker Focus. Click to remove the highlighting that is displayed for 
markers that are in focus in the STR Results Table pane.

• Histogram Settings: Click to open the Histogram Settings dialog box, which 
contains options for customizing the display of the histograms in the Histogram 
Viewer pane. See “Histogram Settings dialog box” on page 112.

Report Click an option to generate the indicated report based on information in the STR 
Results Table pane.

• NGS STR Allele Report (.tsv): The format is a tab-delimited file. 
• NGS STR Allele Report (.fasta): The format is a FASTA report.
• CE STR Allele Report. The format is a tab-delimited file.
• CE STR Allele Report (GM). The format is a tab-delimited file. 
See “STR Analysis viewer reports” below.

Menu Option Description
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• CE STR Allele Report. The CE STR Allele report includes the following information for 
each allele: the Marker, the Allele (which actually represents a particular sequence) and 
the corresponding “height” or read count for the allele sequence. Two options are 
available for this report: a “non-gm” report and a “gm” report. Both reports are a 
tab-separated values (*.tsv) file and both reports provide the same information, but in a 
different layout (organization of the file information), where:

a. The CE STR layout is easy to parse for downstream applications.

b. The CE STR GM layout is appropriate for exporting data to the MaSTR™ software 
application and the STRmix™ software application.

Figure 3-49:  CE STR Allele report example

Figure 3-50:  CE STR GM Allele report example



110 GeneMarkerHTS User’s Manual

Chapter 3
GeneMarkerHTS Viewers and Reports

Viewer Options menu
The Viewer Options menu is located below the STR Viewer main menu. It has three options:

• Mitochondrial Alignment: Opens the sample analysis results in the Mito Alignment viewer. 
This option is available only if an mtDNA alignment project was carried out for the sample. 
See “Mito Alignment Viewer Overview and Layout” on page 75.

• Filter Settings: Opens the Filter Settings dialog box, which contains options for editing the 
display of the STR Results Table pane. See “STR Analysis Viewer STR and STR Stutter 
Filter Settings” on page 123.

• Zoom slider bar: Slide the control on the Zoom slider bar to zoom in or zoom out the 
display of the Histogram Viewer pane. 

Histogram Viewer pane
The Histogram Viewer pane displays a histogram for every STR marker that was analyzed, 
with each bar on the histogram corresponding to a marker allele. From top to bottom, the 
histograms follow the order of the markers in the panel that was used for the analysis. A 
marker histogram has the following characteristics:

• The X-axis variable is the allele name, with the histogram bars arranged in increasing 
order, from the smallest number of tandem repeats to the largest number of tandem 
repeats for all the marker alleles. 

• The Y-axis variable is the total number of read counts (forward + reverse) for the allele. 

• The colored part of a histogram bar contains the non-filtered allele counts with allele 
counts displayed blue and the iso-allele counts displayed in different colors. The number 
of different colors that are displayed is based on how many iso-alleles are called for a 
given allele. 

• The gray part of a histogram bar contains the filtered out allele counts for both true allele 
positions and allele positions that do not have data.

• The “U” allele on the X-axis represents “unknown,” which are the reads that have the 
correct primers for the marker but GeneMarkerHTS cannot detect the number of repeats 
and therefore, cannot assign the read to a specific allele.

If you double-click a histogram in the Histogram Viewer pane, then the corresponding marker 
results are automatically highlighted in the STR Results Table pane. 

By default, when the Histogram Viewer pane first opens, the Zoom in level is set to 100%, 
where each histogram is displayed by itself in the pane. The following options are available 
for adjusting the zoom level of all the histograms at the same in the Histogram Viewer pane, 
where a zoom out level of 100% is the fully zoomed out view and all histograms for the 
project sample are displayed in the Histogram Viewer pane at the same time:

For detailed information about the types of non-filtered allele counts that are 
contained in the colored portion of a histogram bar, see “To specify the STR filter 
settings for an STR analysis project” on page 127.
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• You can use the Zoom slider bar that is displayed on the Viewer Options menu.

• You can use the View menu options of Zoom in and Zoom out:

• You also right-click any histogram that is displayed in the pane to open a context menu 
that has a Zoom in and a Zoom out option.

Figure 3-51:  Fully zoomed out Histogram Viewer pane

Options for working with and adjusting the default display of the histograms in the Histogram 
Viewer pane are available from a histogram context menu and the Histogram Settings dialog 
box. See:

• “Histogram context menu” below.

• “Histogram Settings dialog box” below.

Histogram context menu

You can right-click any histogram in the Histogram Viewer pane to open a context menu with 
the following options:

Option Description
Zoom in Changes the Zoom in level for all the histograms that are displayed in the 

Histogram Viewer pane.

Zoom out Changes the Zoom out level for all the histograms that are displayed in the 
Histogram viewer pane.

Save as Image Exports the individual histogram as a .jpeg.

Save as SVG  Exports the individual histogram as an .svg.

Note: By default, the default location for both Export options is the project folder, but you can 
select a different folder. 
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Histogram Settings dialog box

Options for adjusting the default display of the histograms in the Histogram Viewer pane are 
also available in the Histogram Settings dialog box. To open the dialog box, click View > 
Histogram Settings. 

Figure 3-52:  Histogram Settings dialog box

Table 3-3: Histogram Settings dialog box

Setting Description
Show All Alleles • Not selected: The default value. The filtered out counts for positions with 

data are stacked on top of the non-filtered allele counts. The filtered 
counts for positions without data are displayed as standalone histogram 
bars.

• Selected: The filtered counts for allele positions without data are 
combined into a single histogram bar labeled “Fit” that reflects the total 
number of filtered out counts. The histogram bar is displayed to the right 
of the Unknown (U) allele filtered counts on the far left side of the X-axis. 

See Figure 3-53 on page 113.

Stack sequence bars 
vertically

• Not selected: The default value.The iso-allele count is stacked on top of 
the allele count.

• Selected. The iso-allele count is displayed side by side with the allele 
count at the same location on the X-axis.

See Figure 3-54 on page 113.

Show Interpretive 
Threshold

Selected by default. The Interpretive Threshold (IT) is displayed as a single 
horizontal black line that spans the X-axis of each histogram. 

Note: To change the default color of the line, double-click the Black swatch 
to open the Select Color dialog box, and then select or specify a 
different color.

See Figure 3-55 on page 114.

Show Analytical 
Threshold

Selected by default. The Analytical Threshold (AT) is displayed as a single 
horizontal red line that spans the X-axis of each histogram. 

Note: To change the default color of the line, double-click the Red swatch 
to open the Select Color dialog box, and then select or specify a 
different color.

See Figure 3-55 on page 114. 
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Figure 3-53:  Histogram Viewer pane: D21S11 allele filtered out allele counts displays

As shown in Figure 3-53 above, for Marker D18551, the histogram on the left shows filtered 
counts stacked on top the following allele position with data: 14, 15, 16, 17, 18, and 19. Allele 
positions 9 through 13 have no data, and allele position 20 has no data but does show filtered 
counts. If you select Group Filtered out Alleles into single column, then the histogram display 
is updated to that shown for the histogram on the right. Allele positions 9 through 13, and 20 
have been eliminated from the histogram, the histogram does not extend past the 19th allele 
position, and a single histogram bar labeled Fit is displayed to the right of the Unk histogram 
bar.

Figure 3-54:  Histogram Viewer pane, D2S441 allele 9 and 10 iso-alleles displays

As shown in Figure 3-54 above, for Marker D2S441, the histogram on the left shows the 
default display for iso-alleles with the iso-allele count (green) placed to the right of the allele 
count (blue) at the same location on the X-axis. If you select Stack sequence bars vertically, 
then the histogram display is updated to that shown for the histogram on the right, with the 
iso-allele count (green) stacked on top of the allele count (blue).

     

Filtered counts not grouped into single column Filtered counts grouped into single column

Side-by-Side so-alleles Stacked iso-alleles
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Figure 3-55:  Histogram Viewer pane, IT and AT indicated on the histogram

STR Results Table pane
The STR Results Table pane (also referred to as the STR Results table) displays all the 
alleles that were identified for each marker along with critical analysis information. The 
marker order follows the order of the markers in the panel that was used for the analysis, 
with the background color alternating by marker between gray and white. Default colors are 
used for specific table cells to indicate critical information about the analysis results, such as 
the Filter Status or the User Call for a marker allele. (You can edit any or all of these default 
table cell colors. See “To edit the STR Analysis viewer highlighting colors” on page 160.)

Figure 3-56:  STR Results Table pane

When you are navigating the STR Results Table, note the following:

• If you double-click any cell in the table, then the focus is reset in both the Histogram 

IT and AT indicator lines
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Viewer pane and the STR Results Table pane and all the rows for the corresponding 
marker are automatically highlighted in light blue.

• A selected cell is highlighted in dark blue. To clear all selected cells in a single step, 
including all automatically highlighted marker rows, click either the Histogram Viewer 
pane or the STR Results Table pane, and then press Esc on the client keyboard.

Table 3-4 below lists all the data columns that can be shown for each marker allele in the 
STR Results Table pane and whether the column is shown (visible) by default. Up to 24 data 
columns are available for display in the STR Results Table pane. To edit the table layout, 
including configuring the shown (visible) and hidden table data columns, the order in which 
the columns are displayed, or both, see “To work with the STR Results Table pane 
configuration” on page 117.

Table 3-4: STR Results Table, All available fields

Table Field Default Description
Category One of three categories for the marker: Amelogenin, Autosomal 

STR, or ChrY STR.

Marker X The autosomal STR or Y-STR locus (marker) name.

Allele Name X The capillary electrophoresis (CE) name for a marker. 

Report X Selected by default. If selected, the allele sequence is included in 
the NGS and CE reports. See “STR Analysis viewer reports” on 
page 108.

Filter Status X One of two statuses is possible based on the STR Filter settings 
and STR Stutter Filter settings that are specified for the project.
• Passed: A read passed all specified STR settings.
• Flagged: A read failed one or more specified STR settings.

Filter Reason X The STR filter settings and the STR Stutter filter settings that were 
triggered if a read was flagged.; otherwise, if a read passed, then 
the Filter Reason is set to > IT, which indicates that the allele 
counts were above the interpretative threshold.

SW Call X The software call based on the analysis parameters., where:
• Called means all analysis parameters were met. 
• -1 Stutter (and any other stutter positions) are based on the 

following calculation:

Sequence Total Count of potential stutter peak/Allele Total Count of true 
peak = Peak height ratio of potential stutter peak to True allele

If the value of this calculation falls below the STR Stutter filter 
settings, then the call is Stutter; otherwise, if the value falls above 
the STR Stutter filter settings, then the call is a True Peak.

Note: If multiple stutter calls are available for an allele, then the 
SW call differentiates between them.

User Call X You can double-click the User Call for a flagged Filter Status to 
open the Edit User Call dialog box and enter a custom user call. 
See “To work with user calls and comments in the STR Results 
Table pane” on page 120.
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User Comment X Displays any optional user comments that were made in support 
of/explanation of the User Call. See “To work with user calls and 
comments in the STR Results Table pane” on page 120.

Bracket Sequence X The STR repeat sequence for the allele. The specified Bracket 
Sequence settings determine the format for the sequence display. 
See “To edit the bracket sequence settings” on page 153.

Sequence Group A grouping method that was used prior to Bracket Sequences. 
Maintained only for backwards compatibility.

Sequence Forward 
Count

X The total number of forward reads that contain the bracket 
sequence.

Sequence Reverse 
Count

X The total number of reverse reads that contain the bracket 
sequence.

Sequence Total 
Count

X The total number of reads (F+R) that contain the bracket 
sequence.

Sequence Allele 
Percent

X The percentage of the reads that contain the bracket sequence 
for the allele, calculated as Sequence Total Count/Allele Total 
Count.

Sequence Marker 
Percent

X The percentage of the reads that contain the bracket sequence 
for the marker, calculated as:

Sequence Total Count/Marker Total Count.

Sequence Balance 
Ratio

X The greatest value from all the following calculations:
• Sequence Forward %/Marker Forward %
• Marker Forward %/ Sequence Forward %
• Sequence Reverse %/Marker Reverse %
• Marker Reverse %/Sequence Reverse %

Allele Forward 
Count

X The total number of reads for the allele in the forward direction, 
which includes filtered reads and sequence variants that have the 
same CE allele name.

Allele Reverse 
Count

X The total number of reads for the allele in the reverse direction, 
which includes filtered reads and sequence variants that have the 
same CE allele name.

Allele Total Count X The total number of reads for the allele, which includes filtered 
reads and sequence variants that have the same CE allele name.

Allele Total Count 
Filtered

X The number of reads for the allele that were filtered.

Allele Marker 
Percent

X The ratio of the allele to all alleles for the marker.

Marker Forward 
Count

The total number of reads for the marker in the forward direction, 
including filtered reads.

Marker Reverse 
Count

The total number of reads for the marker in the reverse direction, 
including filtered reads.

Marker Total Count X The total number of reads (F+R) for the marker, including filtered 
reads.

Table 3-4: STR Results Table, All available fields (Continued)

Table Field Default Description
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To work with the STR Results Table pane configuration

When the STR Results Table pane first opens, it opens with a default configuration, which 
means that pre-selected fields are displayed in a pre-set order. You can specify which fields 
to show in the table and which fields to hide from the table. You can also change the order in 
which the fields are displayed in the table. After you edit the table configuration, you can 
apply your changes immediately, or you can first save your changes to a configuration file, 
and then apply them. If you save the STR Results Table pane configuration to a file, you can 
select this file and apply the configuration to any other GeneMarkerHTS project. You can 
also include filtered rows in the STR Results Table pane.

1. Right-click the STR Results Table pane anywhere other than the Heading row to open a 
context menu with three options: Clear User Call, Show Filtered Rows, Open Table 
Config.

Figure 3-57:  STR Results Table pane context menu

2. Continue to one of the following:

• “To include filtered rows in the STR Results Table pane” below.

• “To manually edit the STR Results Table pane configuration” on page 118.

• “To edit the STR Results Table pane configuration by loading a file” on page 119.

To include filtered rows in the STR Results Table pane 
To include filtered rows in the STR Results Table pane, click Show Filtered Rows. The 
context menu closes and the table configuration is updated accordingly.

Marker Total Count 
Filtered

X The total number of reads for the marker that were filtered.

Sequence X The complete sequence for the read, with flanking sequences 
shown in lower case and repeat sequences shown in upper case.

Left Flank X The sequence for the left flank of the sequence read.

Repeat X The sequence for the repeat portion of the reads, but it is not 
shown in brackets.

Right Flank X The sequence for the right flank of the sequence read.

Show Filtered Rows is a toggle. To return the table configuration to its default 
configuration of showing only unfiltered rows, open the STR Results Table pane 
context menu, and then click Show Filtered Rows again.

Table 3-4: STR Results Table, All available fields (Continued)

Table Field Default Description
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To manually edit the STR Results Table pane configuration
1. Click Open Table Config.

The context menu closes. The Table Configuration dialog box opens on top of the STR 
Results Table pane. The dialog box displays all the fields that can be shown in the STR 
Results Table pane in a default order. 

Figure 3-58:  Table Configuration dialog box

2. Do any of the following:

• To show a field in the results table, select the check box in the Visible column.

• To hide a field from the results table, clear the check box in the Visible column.

• To rearrange the order in which the fields are displayed in the results table, drag a 
field and drop it into its new location in the Unique Name (Fields) list.

As you edit the STR Results Table configuration, the display is dynamically updated.

3. After you are satisfied with the edited table configuration, do any of the following:

• To immediately apply the changes to the results table and return to the STR Results 
Table pane, close the Table Configuration dialog box.

• To save the configuration changes so that you can use them for other 
GeneMarkerHTS projects, on the menu for the Table Configuration dialog box:

a. Click File > Save Config As.

The Save Config dialog box opens. The File Type is set to All Files and you 
cannot change this. By default, the location for saving the Config file is set to the 
project folder, but you can select a different location. 

At any time that you are editing the STR Results Table pane configuration, if you 
rearrange the column order, change the visibility setting for one or more columns, 
or both, then you can click File > Reset Columns to return the columns to their 
default order and/or visibility.
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b. Continue to Step 4.

Figure 3-59:  Save Config dialog box

4. Enter a name for the table configuration file, and then click Save.

The Save Config dialog box closes and the Table Configuration dialog box remains 
open. 

5. Close the Table Configuration dialog box.

The configuration changes are applied immediately to the STR Results Table pane.

To edit the STR Results Table pane configuration by loading a file
If a configuration that you prefer for the STR Results Table pane has been saved to a 
configuration file, then you can simply load this file to immediately change the table 
configuration.

1. Click Open Table Config.

The context menu closes. The Table Configuration dialog box opens on top of the STR 
Results Table pane. 

Figure 3-60:  Table Configuration dialog box
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2. On the Table Configuration dialog box, click File > Load Config.

The Load config dialog box opens. The file type is set to All Files. By default, the location 
for the configuration file is set to the project folder for the currently loaded project, but 
you can always browse to a different location to select the config file. For example, you 
can browse to the project folder for a different GeneMarkerHTS project.

Figure 3-61:  Load config dialog box

3. Select the configuration file (the File Type is File), and then click Open.

The Load config dialog box closes. The loaded configuration is immediately applied to 
the STR Results Table pane. 

4. Close the Table Configuration dialog box and continue working in the STR Analysis 
viewer.

To work with user calls and comments in the STR Results 
Table pane

You can do the following for custom user calls and comments in the STR Results Table:

• Enter or edit a custom user call. See “To enter or edit a custom user call” below.

• Enter a comment for any result in the STR Results Table pane. See “To enter comments 
for a result in the STR Results Table pane” on page 121,

• Clear a custom user call. See “To clear a custom user call” on page 122.

To enter or edit a custom user call
You can enter or edit a custom user call for any allele in the STR Results Table pane; 
however, you typically use this feature to enter a custom user call for an allele with a Filter 
Status of Flagged.

1. For an allele with a Filter Status of Flagged, double-click the User Call.

The Edit User Call dialog box opens. If this is the first time that you are entering a user 
call for the allele, then the dialog box is blank; otherwise, the dialog box displays the 
current value for the user call. See Figure 3-62 on page 121.
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Figure 3-62:  Edit User Call dialog box

2. Enter a new custom user call, or edit the current custom user call, and then click OK.

The Edit User Call dialog box closes. The custom user call is now displayed in the User 
Call field. Initially, it is highlighted in the color that is specified for “Flagged” for the STR 
Viewer, with the default value being a golden yellow. After you click out of the cell, the 
cell is highlighted in the color that is specified for “Called” for the STR viewer, with the 
default color being a light green.

3. Optionally, you can now enter a comment/explanation in support of this custom user call. 
See “To enter comments for a result in the STR Results Table pane” below.

To enter comments for a result in the STR Results Table pane
You can enter a comment for any result in the STR Results Table pane. 

1. For any allele in the STR Results Table pane, double-click the User Comment field.

The Edit Comment dialog box opens. If this is the first time that you are entering a 
comment for a custom user call for the project, then both panes of the dialog box are 
blank; otherwise:

• Any comments that were previously entered and saved for any allele in the project 
are displayed in the Saved (left) pane.

• If the selected User Comment field already contains a comment, then the comment 
is displayed in the Current Comment (right) pane. Otherwise, the pane is blank.

Figure 3-63:  Edit Comment dialog box

     

You can edit the color specified for Flagged, Called, or both in the STR Viewer. See 
“To edit the STR Analysis viewer highlighting colors” on page 160..
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2. Do any of the following:

• To enter a new comment, click in the Current Comments field, and then enter a 
comment that explains or supports the custom user call. 

• If the comment is to be a “one-time” comment (used only for this allele and no 
others in the project), then click OK to close the Edit Comment dialog box and 
display the comment in the User Comment field.

• If the comment is to be available for other alleles in the project, then click Save 
Current. The original comment remains displayed in the Current Comments 
pane and a copy of the comment is displayed in the Saved pane. Click OK to 
close the Edit Comment dialog box and display the comment in the User 
Comment field. 

• To enter a previously saved comment, double-click the comment in the Saved pane. 
A copy of the selected comment is displayed in the Current Comment pane. Three 
options are now available. You can:

• Click OK to close the Edit Comment dialog box and display the comment in the 
User Comment field.

• Edit this comment (the source comment that is displayed in the Saved pane is 
not affected), and then click OK to close the Edit Comment dialog box and 
display the comment in the User Comment field.

• Edit this comment (the source comment that is displayed in the Saved pane is 
not affected), and then click Save Current. The comment remains displayed in 
the Current Comments pane and a copy of the comment is displayed in Saved 
pane. Click OK to close the Edit Comment dialog box and display the comment 
in the User Comment field.

To clear a custom user call
If a custom user call has been entered for an allele in the project, you always have the option 
of clearing the call. When you clear a custom user call, the call is reset to the default value of 
blank (no call is displayed). To clear a custom user call, right-click in the appropriate User 
Call field, and on the context menu that opens, click Clear User Call. After you clear a 
custom user call, the cell is again highlighted in the color that is specified for “Flagged” for 
the STR Analysis viewer, with the default value being a golden yellow. 
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STR Analysis Viewer STR and STR Stutter 
Filter Settings

STR and STR filter setting determine the results that are displayed for a project sample in 
the STR Analysis viewer. Both types of settings can be applicable for all markers or alleles, 
or they can marker-specific or allele-specific.

• STR filter settings define the parameters for including a read in the analysis or excluding 
a read from the analysis. 

• STR Stutter filter settings define the parameters for calling an allelic peak as either a true 
peak or a stutter (noise) peak. 

When you open a sample in the STR Analysis viewer, the filter settings that were in place at 
the time that the project was saved determine the results that are initially displayed in the 
viewer, but you can edit these settings to better suit your working requirements.You specify 
the STR filter settings on the STR Filter tab on the Filter Settings dialog box and you specify 
the STR Stutter filter settings on the STR Stutter tab. Four options are available for 
specifying the filter settings for an STR analysis project.

• You can apply the default filter settings as-is.

• You can edit the default values for the filter settings, and then apply the settings.

• You can load previously saved filter settings, and then apply the settings as-is.

• You can load previously saved filter settings and edit any of the values, and then apply 
the settings.

When you load previously saved filter settings, you can load a settings file (*.settings) that 
affects the filter settings on both the STR Filter tab and the STR Stutter tab, or you can load a 
tab-specific settings file (*.csv) that affects the settings on only one tab. See:

• “Filter Settings dialog box, STR Filter Tab” below.

• “Filter Settings dialog box, STR Stutter Tab” on page 133.

Filter Settings dialog box, STR Filter Tab
You specify the STR filter settings for an STR analysis project on the STR Filter tab of the 
Filter Settings dialog box. When the tab first opens, it has the following characteristics:

• The tab displays a single default filter setting that applies to all markers and all alleles.

• The tab opens in a default configuration which means that all available filter settings are 
displayed in a pre-set order. Default values are also provided for the filter settings. 

• The four buttons that are displayed beneath the tab pane–Add Filter, Remove Filter, 
Import and Export–are tab-specific options. 

• Add Filter and Remove Filter are also available from the Edit menu that is displayed 
at the top of the tab. 
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• Import and Export are also available from the File menu that is displayed at the top of 
the tab. 

• The buttons that are displayed at the bottom of the dialog box–Save, Load, Default, OK, 
and Cancel–act on the filter settings on both the STR Filter tab and the STR Stutter tab. 

• Default is also available from the Edit menu that is displayed at the top of the tab. 

Figure 3-64:  Filter Settings dialog box, STR Filter tab

Optionally, before you specify the STR filter settings for an STR analysis project on the tab, 
you can also edit the configuration of the tab to better suit your working requirements, 
including configuring the shown (visible) and hidden table fields, the order in which the fields 
are displayed, or both. See:

• “To edit the STR Filter tab configuration” below.

• “To specify the STR filter settings for an STR analysis project” on page 127.

To edit the STR Filter tab configuration

1. Click Filter Settings.

The Filter Settings dialog box opens. The STR Stutter tab is the open tab. 

2. Open the STR Filter tab.

3. Right-click anywhere in the tab pane and on the context menu that opens, click Open 
Table Config.

The context menu closes. The Table Configuration dialog box opens on top of the STR 
Filter tab. The dialog box displays all the fields that can be displayed on the tab in a 
default order. By default, all available fields are selected for display on the tab. Figure 3-
65 on page 125 shows the Table Configuration dialog box for the STR tab and Table 3-5 
on page 125 details all the fields (filter settings) that are available on the tab.
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Figure 3-65:  Table Configuration dialog box (STR Filter tab)

Table 3-5: Filter Settings dialog box, STR Filter tab

Filter Setting Description
Marker The default is All, which means that all the STR filter settings are 

applied to all the markers for a project sample. 

Allele The default is All, which means that all the STR filter settings are 
applied to all alleles for a project sample. 

Sequence AT Count The number of reads that are required to pass the analytical 
threshold (AT).

Sequence IT Count The number of reads that are required to pass the Interpretive 
Threshold (IT), which results in the sequence being flagged as a 
possible allele. 

Sequence Allele AT Percent The percent of total reads for an allele that are required to pass the 
AT, calculated as Sequence AT Count/Allele Count.

Sequence Allele IT Percent The percent of total reads for an allele that are required to pass the 
IT, calculated as Sequence IT Count/Allele Count.

Sequence Marker AT 
Percent

The percent of total reads for a marker that are required to pass the 
AT, calculated as Sequence AT Count/Marker Count.

Sequence Marker IT 
Percent

The percent of total reads for a marker that are required to pass the 
IT, calculated as Sequence IT Count/Marker Count.

Maximum Sequence AT 
Balance

The balance is set to the greatest value out of the following 
calculations:
• SequenceForward%/MarkerFoward%
• MarkerForward%/SequenceForward%
• SequenceReverse%/MarkerReverse%
• MarkerReverse%/SequenceReverse%

Note: Any balance value that is greater than the balance value that 
is set here is automatically filtered out, which means that the 
sequence is not called as an allele. To disable filtering, set 
the value here to inf.
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4. Do any of the following:

• To show a field on the tab, select the check box in the Visible column.

• To hide a field from the tab display, clear the check box in the Visible column.

• To rearrange the order in which the fields are displayed in the results table, drag a 
field and drop it into its new location in the Unique Name (Fields) list.

As you edit the STR Filter tab configuration, the display is dynamically updated.

5. After you are satisfied with the edited tab configuration, do one of the following:

• To immediately apply the changes to the STR Filter tab and return to the tab, close 
the Table Configuration dialog box.

• To save the configuration changes so that you can use them for other 
GeneMarkerHTS projects, on the Table Configuration dialog box, do the following:

a. Click File > Save Config As.

The Save Config dialog box opens. 

Figure 3-66:  Save Config dialog box

Maximum Sequence IT 
Balance

The balance is set to the greatest value out of the following 
calculations:
• SequenceForward%/MarkerFoward%
• MarkerForward%/SequenceForward%
• SequenceReverse%/MarkerReverse%
• MarkerReverse%/SequenceReverse%

Note: Any balance value that is greater than the balance value that 
is set here and that is less than the Maximum Sequence AT 
Balance is automatically flagged as a possible allele. To 
disable flagging, set the value here to inf.

At any time that you are editing the STR Filter tab configuration, you can click 
File > Reset Columns to return the columns to their default order and/or visibility.

Table 3-5: Filter Settings dialog box, STR Filter tab (Continued)

Filter Setting Description
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b. Enter a name for the configuration file.

c. Optionally, select a different location in which to save the file. (By default, the 
location is set to the project folder.)

d. Click Save.

The Save Config dialog box closes and the Table Configuration dialog box 
remains open. 

e. Close the Table Configuration dialog box.

The configuration changes are applied immediately to the STR Filter tab.

To specify the STR filter settings for an STR analysis 
project

1. Click Filter Settings.

The Filter Settings dialog box opens. The STR Stutter tab is the open tab. 

2. Open the STR Filter tab.

A single default filter setting is displayed. The settings are applicable for all alleles for all 
project markers.

3. Review the default settings, noting the following:

• Any sequence/allele that has read counts/percentages that fall below the AT are not 
called and are filtered from the results. (The gray portion of the histogram bar 
contains these values.)

• Any sequence/allele that has read counts/percentages that fall in between the AT 
and the IT are flagged as a possible allele, and the user must enter a custom call. 
(The colored portion of the histogram bar contains these values, regardless of the 
user call.) 

• Any sequence/allele that has read counts/percentages that are greater than the IT 
are called as an allele. (The colored portion of the histogram bar contains these 
values.)

4. If you are satisfied that the default values are correct for your project, then go to “To 
finish specifying the settings for an STR analysis project (STR tab)” on page 130; 
otherwise, go to one of the following:

• “To edit the STR filter settings” on page 128.

• “To load an STR/STR Stutter filter settings file” on page 129.

• “To import an STR Stutter tab-specific filter settings file” on page 138.

If your lab does not use the Interpretive Threshold (IT), then you should set the IT 
values to match the Analytical Threshold (AT) values. See Table 3-5 on page 125.
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To edit the STR filter settings
1. Edit the filter settings as appropriate for the project, noting the following:

• For a detailed explanation of the values for an STR filter setting, see Table 3-5 on 
page 125.

• The default value of All which means that all the STR filter settings are applied to all 
the alleles for all the markers in a project sample. 

• You can add more filter settings, delete any filter settings, or both. 

• If you add more filter settings, then marker-specific settings and allele-specific 
setting take precedence over “All” filter settings. See “Marker-specific and Allele-
specific settings” below.

• You can select only a single filter at a time for deletion.

• If you edit any of the default values for the STR filter settings, and want to return 
them to their default values, click Default, and then click Yes in the Default values 
message that opens. The values for all STR filter settings are immediately reset to 
their default values.

Marker-specific and Allele-specific settings

2. Continue to “To finish specifying the settings for an STR analysis project (STR tab)” on 
page 130.

To open a tooltip that provides an explanation of an STR filter setting, hold your 
mouse pointer over the column header for the setting.

Marker-specific settings: To set marker-specific settings, you must carry out the following 
procedure in its entirety for every marker-specific filter setting that you are adding.
1. Click Add Filter.

A new row is displayed for adding a new filter setting.
2. On the Marker drop-down list, select the marker for which you are adding the 

marker-specific settings.
3. Edit any or all the STR settings other than the Allele default value of All for the marker. 

See Table 3-5 on page 125.

Allele-specific settings: To set allele-specific settings, you must carry out the following 
procedure in its entirety for every allele-specific filter setting that you are adding.
1. Click Add Filter.

A new row is displayed for adding a new filter setting.
2. On the Marker drop-down list, select the marker for which you are adding the 

allele-specific setting.
3. In the Allele field, select the default value of “All,” and then edit the field to reflect the 

correct allele information.
4. Edit any or all the STR settings for the allele. See Table 3-5 on page 125.
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To load an STR/STR Stutter filter settings file
1. Click Load. 

The Load Filter Settings dialog box opens. 

Figure 3-67:  Load Filter Settings dialog box

2. Browse to and select a Settings File(*.settings) file, and then click Open.

The Load Filter Settings dialog box closes. Both the STR Filter tab and the STR Stutter 
tab are populated with the values in the settings file. 

3. Review the loaded filter settings, and then do one of the following:

• If you are satisfied that the loaded filter settings are correct as-is for your project, 
then go to “To finish specifying the settings for an STR analysis project (STR tab)” on 
page 130. 

• If you are not satisfied with the loaded filter settings, then go “To edit the STR filter 
settings” on page 128.
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To import an STR Filter tab-specific filter settings file
1. Click Import.

The Import STR Filter Settings dialog box opens.

Figure 3-68:  Import STR Filter Settings dialog box

2. Browse to and select the Comma Separated Values(*.csv) file, and then click Open. 

The Import STR Filter Settings dialog box closes. Only the STR Filter tab is populated 
with the values in the settings file. 

3. Review the loaded filter settings, and then do one of the following:

• If you are satisfied that the imported filter settings are correct as-is for your project, 
then go to “To finish specifying the settings for an STR analysis project (STR tab)” 
below.

• If you are not satisfied with the imported filter settings, then go “To edit the STR filter 
settings” on page 128.

To finish specifying the settings for an STR analysis 
project (STR tab)

Do one of the following:

• Immediately apply the filter settings. Click OK to close the Filter Settings dialog box and 
immediately apply the filter settings. The STR Analysis viewer display is dynamically 
updated based on the settings.

• Save the filter settings before applying them. See “To save the STR filter settings before 
applying them” on page 131.

• Export the filter settings to a tab-specific filter settings file before applying them. See “To 
export the STR filter settings before applying them” on page 132.
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To save the STR filter settings before applying them
If you edited any of the STR filter settings, then to save these edits before applying them, you 
must save the settings to a Filter Settings (*.settings) file. When you save a filter settings file, 
the settings on both the STR Filter tab and STR Stutter tab are saved.

1. Click Save. 

The Save Filter Settings dialog box opens. 

Figure 3-69:  Save Filter Settings dialog box

Note the following when you are saving a filter settings file:

• No default name is provided for the file.

• The file type is Filter Settings File(*.settings) and you cannot change this. 

• The default location for saving the filter settings file is the project folder, but you can 
always select a different location.

2. Enter a name for the file. 

3. Optionally, select a different location in which to save the file.

4. Click Save. 

The Save Filter Settings dialog box closes.

5. Click OK.

The Filter Settings dialog box closes. The STR Analysis viewer display is immediately 
updated based on the applied settings.
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To export the STR filter settings before applying them
If you edited any of the filter settings and you want to save these edits only on the STR Filter 
tab before applying them, then you must export the filter settings to a Comma Separated 
Values (*.csv) file. 

1. Click Export.

The Export STR Filter Settings dialog box opens. 

Figure 3-70:  Export STR Filter Settings dialog box

Note the following when you are exporting and saving a STR Filter tab-specific filter 
settings file:

• The default name is set to gmhts_str_filter_settings. You can leave the filename 
as-is, or you can edit it. 

• The file type is Comma Separated Values (.csv) and you cannot change this. 

• The default location for saving the tab-specific filter settings file is the project folder, 
but you can always select a different location.

2. Optionally, enter a different name for the file, select a different location in which to save 
the file, or both.

3. Click Save.

The Export STR Filter Settings dialog box closes.

4. Click OK.

The Filter Settings dialog box closes. The STR Analysis viewer display is immediately 
updated based on the applied settings.
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Filter Settings dialog box, STR Stutter Tab
You specify the STR Stutter filter settings on the STR Stutter tab of the Filter Settings dialog 
box. When the tab first opens, it has the following characteristics:

• The tab displays a single default filter setting that applies to all markers and all alleles.

• The tab opens in a default configuration which means that all available filter parameters 
are displayed in a pre-set order. Default values are also provided for the filter parameters. 

• The four buttons that are displayed beneath the tab pane–Add Filter, Remove Filter, 
Import and Export–are tab-specific options.

• Add Filter and Remove Filter are also available from the Edit menu that is displayed 
at the top of the tab.

• Import and Export are also available from the File menu that is displayed at the top of 
the tab.

• The buttons that are displayed at the bottom of the dialog box–Save, Load, Default, OK, 
and Cancel–act on the filter settings on both tabs. 

• Default is also available from the Edit menu that is displayed at the top of the tab. 

Figure 3-71:  Filter Settings dialog box, STR Stutter tab

Optionally, before you specify the STR Stutter settings for an STR analysis project on the 
tab, you can also edit the configuration of the tab to better suit your working requirements, 
including configuring the shown (visible) and hidden table fields, the order in which the fields 
are displayed, or both. See:

• “To edit the STR Stutter tab configuration” below.

• “To specify the STR Stutter filter settings for an STR analysis project” on page 135.

To edit the STR Stutter tab configuration

1. Click Filter Settings.

The Filter Settings dialog box opens. The STR Stutter tab is the open tab. 
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2. Right-click anywhere in the tab pane and on the context menu that opens, click Open 
Table Config.

The context menu closes. The Table Configuration dialog box opens on top of the STR 
Stutter tab. The dialog box displays all the fields that can be displayed on the tab in a 
default order. By default, all available fields are selected for display on the tab. Figure 3-
72 below shows the Table Configuration dialog box for the STR Stutter tab and Table 3-6 
below details all the fields (filter settings) that are available on the tab.

Figure 3-72:  Table Configuration dialog box (STR Stutter tab)

3. Do any or all of the following:

• To show a field on the tab, select the check box in the Visible column.

• To hide a field from the tab display, clear the check box in the Visible column.

• To rearrange the order in which the fields are displayed in the results table, drag a 
field and drop it into its new location in the Unique Name (Fields) list.

As you edit the STR Stutter tab configuration, the display is dynamically updated.

     

Table 3-6: Filter Settings dialog box, STR Stutter tab

Filter Setting Description
Note: The descriptions provided here are for informational purposes only. For detailed information 

about editing the STR Stutter filter settings values for an STR analysis, “To specify the STR 
Stutter filter settings for an STR analysis project” on page 135.

Marker The available markers for the project. Automatically populated based on the 
loaded panel. 

Repeat Length Automatically populated based on the loaded panel. 

From Allele
To Allele

The default value for both parameters is All. 

Type The stutter position.

Ratio The ratio of the total number of sequence counts in the stutter position to the 
total number of allele counts for the main peak.

At any time that you are editing the STR Stutter tab configuration, you can click 
File > Reset Columns to return the columns to their default order and/or visibility.
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4. After you are satisfied with the edited table configuration, do one of the following:

• To immediately apply the changes to the STR Stutter tab and return to the tab, close 
the Table Configuration dialog box.

• To save the configuration changes so that you can use them for other 
GeneMarkerHTS projects, on the Table Configuration dialog box, do the following:

a. Click File > Save Config As.

The Save Config dialog box opens.

Figure 3-73:  Save Config dialog box

b. Enter a name for the configuration file.

c. Optionally, select a different location in which to save the file. (By default, the 
location is set to the project folder.)

d. Click Save.

The Save Config dialog box closes and the Table Configuration dialog box 
remains open. 

e. Close the Table Configuration dialog box.

The configuration changes are applied immediately to the STR Stutter tab.

To specify the STR Stutter filter settings for an STR 
analysis project

1. Do one of the following:

• If the Filter Settings dialog box is already open, then go to Step 2.

• On the Viewer Options menu, click Filter Settings.

The Filter Settings dialog box opens. The STR Stutter tab is the open tab. 
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2. Review the default settings, and if you are satisfied that the default values are correct 
for your project, then go to “To finish specifying the settings for an STR analysis project 
(STR Stutter tab)” on page 138; otherwise, go to one of the following:

• “To edit the STR Stutter filter settings” below. 

• “To load an STR/STR Stutter filter settings file” on page 137.

• “To import an STR Stutter tab-specific filter settings file” on page 138.

To edit the STR Stutter filter settings
When you are editing the STR Stutter filter settings, note the following:

• The default value of All means that which means that all the STR filter settings are applied 
to all the alleles for all the markers in a project sample. 

• You can add more filter settings, delete any filter settings, or both. 

• If you add more filter settings, then marker-specific settings and allele-specific setting 
take precedence over “All” filter settings. 

• You can select only a single filter at a time for deletion.

• If you edit any of the default values for the STR Stutter filter settings, and want to return 
them to their default values, click Default, and then click Yes in the Default values 
message that opens. The values for all STR Stutter filter settings are immediately reset 
to their default values.

1. Edit the settings as appropriate for the project.

To open a tooltip that provides an explanation of the STR Stutter filter setting, hold 
your mouse pointer over the column header for the setting.

Setting Description
Marker To add a marker-specific STR Stutter filter setting:

1. Click Add Filter.
A new row is displayed for adding a stutter filter.

2. On the Marker drop-down list, select a marker.
3. Leave the From Allele value and the To Allele Value set to All.

Repeat Length The marker repeat length. Automatically populated based on the loaded 
panel. You should not edit this value.

From Allele
To Allele

The default value for both parameters is All. You must leave these values 
as-is for marker-specific stutter positions. If allele-specific stutter filters are 
appropriate, for example, the LUS stutter filter, then do the following:
1. Click Add Filter.

A new row is displayed for adding a stutter filter.
2. On the Marker drop-down list, select a marker.
3. Edit the value for the From Allele parameter and then tab out of the field.

The value for the To Allele parameter is automatically adjusted.
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2. Continue to “To finish specifying the settings for an STR analysis project (STR Stutter 
tab)” on page 138.

To load an STR/STR Stutter filter settings file
1. Click Load. 

The Load Filter Settings dialog box opens. 

Figure 3-74:  Filter Settings dialog box

2. Browse to and select a Settings File(*.settings) file, and then click Open.

The Load Filter Settings dialog box closes. Both the STR Filter tab and the STR Stutter 
tab are populated with the values in the settings file. 

3. Review the loaded filter settings, and do one of the following:

• If you are satisfied that the loaded filter settings are correct as-is for your project, 
then go to “To finish specifying the settings for an STR analysis project (STR Stutter 
tab)” on page 138.

• If you are not satisfied with the loaded filter settings for your project, then go to “To 
edit the STR Stutter filter settings” on page 136.

     

Type Set the stutter position:
• -1: One repeat smaller.
• -2: Two repeats smaller.
• -0.5: 1/2 repeat smaller, typically 2 bp smaller.
• +1: One repeat larger.
• +0.5: 1/2 repeat larger, typically 2 bp larger.

Ratio The ratio of the total number of sequence counts in the stutter position to the 
total number of allele counts for the main peak.

Setting Description
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To import an STR Stutter tab-specific filter settings file
1. Click Import.

The Import STR Stutter Settings dialog box opens.

Figure 3-75:  Import STR Stutter Settings dialog box

2. Browse to and select the STR Stutter tab-specific Comma Separated Values(*.csv) file, 
and then click Open. 

The Import STR Stutter Settings dialog box closes. Only the STR Stutter tab is populated 
with the values in the settings file. 

3. Review the imported filter settings, and do one of the following:

• If you are satisfied that the imported filter settings are correct as-is for your project, 
then go to “To finish specifying the settings for an STR analysis project (STR Stutter 
tab)” on page 138.

• If you are not satisfied with the imported filter settings for your project, then go to “To 
edit the STR Stutter filter settings” on page 136.

To finish specifying the settings for an STR analysis 
project (STR Stutter tab)

Do one of the following:

• Immediately apply the filter settings. Click OK to close the Filter Settings dialog box and 
immediately apply the settings. The STR Analysis viewer display is dynamically updated 
based on the settings

• Save the filter settings before applying them. See “To save the STR Stutter filter settings 
before applying them” on page 139.

• Export the filter settings to a tab-specific filter settings file before applying them. See “To 
export the STR Stutter filter settings before applying them” on page 140.
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To save the STR Stutter filter settings before applying them
If you edited any of the STR Stutter filter settings and you want to save these edits before 
applying them, then you must save the settings to a Filter Settings(*.settings) file. When you 
save a filter settings file, the settings on both the STR Filter tab and STR Stutter tab are 
saved.

1. Click Save. 

The Save Filter Settings dialog box opens. 

Figure 3-76:  Save Filter Settings dialog box

Note the following when you are saving a filter settings file:

• No default name is provided for the file.

• The file type is Filter Settings (*.settings) and you cannot change this. 

• The default location for saving the filter settings file is the project folder, but you can 
always select a different location.

2. Enter a name for the file. 

3. Optionally, select a different location in which to save the file.

4. Click Save.

The Save Filter Settings dialog box closes.

5. Click OK. 

The Filter Settings dialog box closes. The STR Analysis viewer display is immediately 
updated based on the applied settings.
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To export the STR Stutter filter settings before applying them
If you edited any of the filter settings and you want to save these edits only on the STR 
Stutter tab before applying them, then you must export save the filter settings to a Comma 
Separated Values (*.csv) file. 

1. Click Export.

The Export STR Stutter Settings dialog box opens. 

Figure 3-77:  Save STR Stutter Filter Settings dialog box

Note the following when you are exporting and saving a tab-specific filter settings file:

• The default name is set to gmhts_str_stutter_settings. You can leave the filename 
as-is, or you can edit it. 

• The file type is Comma Separated Values (.csv) and you cannot change this. 

• The default location for saving the tab-specific filter settings file is the project folder, 
but you can always select a different location.

2. Optionally, enter a different name for the file, select a different location in which to save 
the file, or both.

3. Click Save.

The Export STR Stutter Settings dialog box closes

4. Click OK.

The Filter Settings dialog box closes. The STR Analysis viewer display is immediately 
updated based on the applied settings.
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Comparison Viewer
You can compare the results for two or more samples or all samples in an mtDNA project in 
a single Comparison viewer window. 

Figure 3-78:  Comparison viewer

From top to bottom, the Comparison viewer has three major components:

• The main menu. See “Comparison viewer main menu” below.

• The Comparison pane. See “Sample to Sample Comparison pane” on page 142.

• The Variant Comparison pane. See “Variant Comparison pane” on page 143.

Comparison viewer main menu
Figure 3-79:  Comparison viewer main menu

The Comparison viewer main menu has four unique options.

For detailed information about opening an existing project and selecting two or 
more samples to compare, see “To work with an existing GeneMarkerHTS project” 
on page 68.

Option Description
Comparison Filter Settings Opens the Filter Settings dialog box. You use the options on this 

dialog box to adjust the filter settings for the project and 
dynamically update the Comparison viewer display. 

Note: Any edits that you make to the project filter settings here 
affect only the Comparison viewer display. They do not 
affect the Mito Alignment viewer display.

<Variant Comparison Type> Three available options. Applicable only for the Sample to Sample 
Comparison pane. See “Sample to Sample Comparison pane” on 
page 142.
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Sample to Sample Comparison pane
The Sample to Sample Comparison (top) pane for the Comparison viewer is a correlation 
table, that, by default, displays the percentage of major alleles that are shared among all the 
project samples, with the Jaccard Index measurement used to calculate the comparison. 
Diagonal cells in the correlation table compare a sample to itself and by default, are 
highlighted in black. All other cells in the correlation table compare one sample to another for 
the proportion of shared variants. By default, these cells are highlighted in a blue color 
gradient from 0 to 100%, where 0% cells are blank/white and 100% cells are the darkest blue 
in the gradient. The Proportion of Shared Variants, which is a read-only legend that is located 
above the pane, shows this gradient. See Figure 3-80 below.

Figure 3-80:  Comparison viewer, Sample to Sample Comparison pane

The following options are available for the Sample to Sample Comparison pane.

• Save As: You can click the Save As option that is displayed above the Comparison pane 
to open the Save Sample to Sample Comparison As dialog box and save the information 
that is displayed in the pane as text (.txt) file with a filename of your choosing. By default, 
the text file is saved in the same directory as the project, but you can always select a 
different location.

Figure 3-81:  Save Sample to Sample Comparison As

• Column variant type and Row variant type: You can change the variant types that are 
used for calculating the correlation (Major, Minor, or Both). You can select the same or 
different variant types for the column and the row.

You can change the default highlighting colors that are used in the Sample to 
Sample Comparison pane. See “To edit the Comparison viewer variant 
highlighting colors” on page 158.
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• Show Percentage: Selected by default. Shows the percentage of shared variants for the 
samples that are being compared. If you clear this option, then the absolute number of 
shared variants is shown instead.

• Use Jacquard Index. Selected by default. The Jaccard Index measurement is used for the 
calculation, which results in the variant values in either the row or the column being used 
in the divisor. If you clear this option, then a Simple measurement is used for the 
calculation, which results in only the variant value in the column being used in the divisor.

As you change any of the options for the correlation calculation, both the correlation table 
display and the correlation calculation are updated accordingly. You can hold your mouse 
pointer over any entry in the correlation table to open a tooltip that displays the percentage or 
absolute number of matched variants, and if applicable, all the variants that are unique to 
each appropriate sample. 

Figure 3-82:  Correlation Table tooltip

Variant Comparison pane
The Variant Comparison (bottom) pane lists the all the variants that were found in at least 
one sample for the project, where each column is a different sample and the variant 
percentage for the sample is displayed. The display provides a quick way of visually 
determining which variants were shared among samples and which were not. Variants that 
can be classified as a major allele or as a minor allele are highlighted, by default, in blue or 
gold, respectively. If a variant was determined to be a Low Coverage variant, (the Total 
Coverage for the variant falls below the Total Coverage threshold that was set for the 
project), then by default, the variant is highlighted in red. 

Figure 3-83:  Variant Comparison pane

You can also use the options that are available on the Comparison viewer main 
menu (Major to Major, Major to Minor, and Minor to Minor) to quickly reset the 
variant types that are used for the calculation of the correlation.
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The following options are available for the Variant Comparison pane.

• Save As: You can click the Save As option that is displayed above the Comparison pane 
to open the Save Variant Comparison As dialog box and save the information that is 
displayed in the pane as text (.txt) file with a filename of your choosing. By default, the 
text file is saved in the same directory as the project, but you can always select a different 
location.

Figure 3-84:  Save Variant Comparison As dialog box

• Comparison Filter Settings: The specific variants that are initially displayed in the Variant 
Comparison pane are determined by the filter settings, including the Total Coverage 
threshold, that were in place at the time that the mtDNA project was saved. To 
dynamically change the display, on the Comparison viewer main menu, click Comparison 
Filter Settings to open the Filter Settings dialog box, and make any needed edits. See “To 
specify the variant call settings for an mtDNA project” on page 93.

You can change the default highlighting colors that are used in the Variant 
Comparison pane. See “To edit the Comparison viewer variant highlighting colors” 
on page 158.
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You use GeneMarkerHTS Application settings to quickly configure the application to provide 
a customized experience. You can use these settings to enable or disable features or 
configure feature behavior so that GeneMarkerHTS best fits your working needs. You 
configure GeneMarkerHTS application settings in the Application Settings dialog box. This 
appendix details the GeneMarkerHTS Application Settings dialog box including its layout, all 
the available settings, and how to manage and configure the different settings.

This appendix covers the following topics:

• “GeneMarkerHTS Application Settings Dialog Box Layout” on page 147.

• “Configuring GeneMarkerHTS Project Directory Settings” on page 148.

• “Configuring GeneMarkerHTS License Settings” on page 150.

• “Configuring GeneMarkerHTS Visuals Settings” on page 152.
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GeneMarkerHTS Application Settings Dialog 
Box Layout

You configure GeneMarkerHTS application settings in the Application Settings dialog box. 
The dialog box provides the options for configuring the SoftGenetics license settings, the 
GeneMarkerHTS project directory settings, and the Viewer and Report visualization settings. 
When you edit application setting, the change is persistent for the GeneMarkerHTS instance. 

You can open the GeneMarkerHTS Application Settings dialog box from two locations in the 
application:

• From the GeneMarkerHTS main menu: File > Settings.

• On the GeneMarkerHTS main window, click the Application Settings icon .

From top to bottom, the dialog box has three panes:

• (1) General: Displays the options for setting project directory location and behavior.

• (2) License: Displays the options for configuring the SoftGenetics license settings.

• (3) Visuals: Displays the options for configuring the bracket sequence settings and the 
color settings for the different GeneMarkerHTS viewers and reports.

A (4) Reset to default button is displayed at the bottom of the dialog box. Click this button to 
reset all application setting values in all panes to their default values in a single step.

Figure A-1:  GeneMarkerHTS Application Settings dialog box

1

2

3

4
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Configuring GeneMarkerHTS Project Directory 
Settings

The General pane contains the GeneMarkerHTS project directory settings. There are two 
project directory settings that you can configure:

• Remember last opened samples directory. By default, GeneMarkerHTS remembers the 
last opened sample files directory, which means any time that you are adding sample files 
to a project, GeneMarkerHTS automatically points to the directory that was last used for 
adding sample files to a project. You can leave the default setting as-is, or you can clear 
this selection.

• Common AppData Directory. The Common Application Data Directory is the client 
directory in which custom project panels are saved. The directory is automatically created 
during installation, and by default, it is set to the following location:

C:\Users\<user Name>\Downloads\GMHTS. 

You can leave this directory location as-is, or you can set a different default Common 
Application Data directory. 

To configure GeneMarkerHTS project directory settings
1. On the Application Settings dialog box, ensure that the General pane is visible. 

2. Do one or both of the following:

• Clear Remember last opened samples directory. 

If you clear this option, then when you are adding sample files to a project , 
GeneMarkerHTS opens the installation directory and you must browse to and select 
the sample files directory.

• Next to the Common AppData Directory display field, click the Browse button to 
open the Choose Common Application Directory dialog box, and then select a 
different default Common Application Data directory.

Figure A-2:  Choose Common Application Data Directory dialog box
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3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to add and/or edit other application settings as needed. 
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Configuring GeneMarkerHTS License Settings
The License pane contains the GeneMarkerHTS license settings. There are two 
GeneMarkerHTS license settings that you can configure:

• The license type (Trial or FullAligner).

• The SoftGenetics LSM connection settings.

You must configure your license type of Trial or FullAligner (Network or Local) before you run 
your first GeneMarkerHTS project, noting the following: 

• A Trial license is valid for 35 days. You are not required to register a Trial license; 
however, after your 35 days has expired, you must purchase a commercial license and 
then register the license properly before you can continue to use GeneMarkerHTS. See 
“To set a Trial license” below.

• After you purchase and configure a commercial license, you typically do not need to edit 
the license type and/or LSM connection settings again; however, if you must edit the 
license type and/or reconfigure the LSM connection settings, see the appropriate topic:

• “Registering a GeneMarkerHTS Network License” on page 25.

• “Registering a GeneMarkerHTS Local License” on page 37.

To set a Trial license
By default, when you install GeneMarkerHTS, the License Type is set to FullAligner, which is 
applicable for a commercial (purchased) installation. A non-commercial installation of 
GeneMarkerHTS requires that you set the License Type to Trial. A Trial license is valid for 35 
days. After 35 days, to continue using GeneMarkerHTS, you must set the License Type to 
FullAligner and purchase and register a commercial (network or local) license.

1. On the GeneMarkerHTS main window, click the Application Settings icon. 

The Application Settings dialog box opens. From top to bottom, the dialog box has three 
panes: General, License, and Visuals.

2. Ensure that the License pane is visible.

The pane indicates that GeneMarkerHTS was installed with a FullAligner license.

Figure A-3:  Application Settings dialog box, License pane with FullAligner license
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3. On the License Type drop-down list, select Trial.

Configure is now disabled.

4. Close the Application Settings dialog box.

GeneMarkerHTS is now ready for use for 35 days. After 35 days, you can still open 
GeneMarkerHTS but it is not operable. You must purchase a commercial license to 
continue to use GeneMarkerHTS.



152 GeneMarkerHTS User’s Manual

Appendix A
GeneMarkerHTS Application Settings

Configuring GeneMarkerHTS Visuals Settings
The Visuals pane contains the GeneMarkerHTS bracket sequence settings and color 
settings. The Visuals pane is divided into eight sub-panes for configuring these settings, 
which from top to bottom are the following.

• The Bracket Sequence Settings sub-pane. The bracket sequence settings determine how 
the STR results are displayed in the STR Results Table pane in the STR Viewer.

• The Color settings sub-panes, which from top to bottom are the following:

• The Sample Viewer Preview sub-pane, which shows what the Pane displays 
currently look like in the Mito Alignment Viewer based on the colors and other settings 
that are specified in the Sample Viewer sub-pane.

• The Sample Viewer sub-pane, which shows the currently selected colors and variant 
visibility for the Pane displays in the Mito Alignment Viewer.

• The Global Viewer sub-pane, which shows the currently selected colors for the Global 
Viewer pane display in the Mito Alignment Viewer.

• The Report Table Category pane, which shows the currently selected colors for the 
Variants Table pane in the Mito Alignment Viewer.

• The Comparison Viewer Sample to Sample sub-pane, which shows the currently 
selected colors that indicate the overlap between two samples for the Sample to 
Sample pane of the Comparison Viewer.

• The Comparison Viewer Variant sub-pane, which shows the currently selected colors 
for the different variant classifications (major or minor) and the color that indicates if 
the variant was a low coverage variant for the Variant pane of the Comparison 
Viewer.

• The STR Viewer sub-pane, which shows the currently selected colors for the different 
STR statuses (Flagged, Passed, Filtered, and Called) in the STR Viewer.

To edit the Visuals application settings
1. Open the Application Settings dialog box.

2. On the Application Settings dialog box, ensure that the Visuals pane is visible. 

See Figure A-4 on page 153.

     

To make it easier for you to edit any of the Visuals pane settings, use standard 
Windows functions to increase the size of the Application Settings dialog box. To 
view all the sub-panes that are displayed in the Visuals pane, use the scroll bar 
that is displayed to the right of the Visuals pane.



GeneMarkerHTS User’s Manual 153

Appendix A
GeneMarkerHTS Application Settings

Figure A-4:  Application Settings dialog box, Visuals pane

3. Continue to any of the following:

• “To edit the bracket sequence settings” below.

• “To edit the background and highlighting colors in the  Pile-up pane display” on page 
154.

• “To edit the visibility and default nucleotide colors for the Pile-up pane display” on 
page 155.

• “To edit the Global Viewer pane colors” on page 157.

• “To edit the Variants table (Report Table) Category colors” on page 158.

• “To edit the Comparison viewer variant highlighting colors” on page 158.

To edit the bracket sequence settings

The bracket sequence settings determine how the STR results are displayed in the STR 
Results Table pane.

Figure A-5:  STR Results Table pane, Bracket Sequence example

Use the scroll bar that is 
displayed to the right of 
the Visuals pane to move 
through all the available 
sub-panes.Use standard 
Windows controls to 
resize the Application 
Settings dialog box so 
that you can scroll 
completely through all 
the Visuals sub-panes.
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1. On the Application Settings dialog box, ensure that the Bracket Sequence Settings 
sub-pane is visible.

2. Edit the sequence settings as appropriate.

3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed. 

To edit the background and highlighting colors in the 
Pile-up pane display

In the Sample Previewer sub-pane, you specify the colors to use for background/highlighting 
and the nucleotides in the Pile-up pane display for the Mito Alignment viewer. If you edit the 
display colors, then the Sample Viewer Previewer sub-pane is dynamically updated with 
your settings. 

1. On the Application Settings dialog box, ensure that the Sample Previewer sub-pane is 
visible.

2. Edit the background/highlighting colors and/or the nucleotide colors, noting the following:

• If Variants is selected (the default value), then all nucleotides other than variant 
nucleotides are displayed in color on a white background. Conversely, variant 
nucleotides are displayed in white on a colored background (referred to as a 

Setting Description
Brackets on bases Not selected by default. Select this setting to surround the bases in 

an STR in brackets.
• The default format: TGAT[3]
• The setting is selected: [TGAT][3]

Brackets on numbers Selected by default. Repeat numbers for STRs are surrounded by 
brackets. 
• The default format: TGAT[3]
• The setting cleared: TGAT3

Show number if “1” Selected by default. The number 1 is displayed for only a single 
repeat.
• The default format: [TGAT][3]TGA[1][TGAT[3]
• The setting is cleared: [TGAT][3]TGA[TGAT][3]

Delimit bases and repeats Not selected by default. No delimiters are displayed between the 
bases in an STR and the repeat numbers. If you select this option, 
and then do not specify any delimiter, the default delimiter is space. 
• The default format: TGAT[3]_TGA_TGAT[3]
• The setting is selected: TGAT_[3]_TGA_TGAT_[3] (The specified 

delimiter is an underscore.)

Note: You can designate any special character as a delimiter.
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highlighted variant). 

Figure A-6:  Variants selected for Pane displays

• If Blocks is selected, then all nucleotides are displayed in white on a colored background. 

Figure A-7:  Blocks selected for Pane displays

Figure A-8:  Variants and Blocks selected for Pane displays in the Mito Alignment Viewer

3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed.

To edit the visibility and default nucleotide colors for the 
Pile-up pane display

In the Sample Viewer sub-pane, you specify the variant visibility and the nucleotide colors in 
the Pile-up pane display for the Mito Alignment viewer. 

• Variant Visibility. Determines how dimmed non-variant nucleotides are when compared 
to the variant nucleotides when both Variants and Blocks are selected for the pane display 
in the Mito Alignment viewer. The default value is 40%.

• The sub-pane also displays the various colors that are to be used in the Pane displays 
where the default nucleotide colors are the following:

• For non-variant nucleotides and SNPs: If Variants is selected, then Green, Blue, 
Black, and Red indicate the colors for the nucleotides A, C, G, and T, respectively. If 

You can select both Variants and Blocks for the display. In this case, all 
nucleotides are still displayed in white on a colored background; however, all 
nucleotides other than variant nucleotides are dimmed and all variant nucleotides 
are highlighted to visually differentiate them from non-variant nucleotides. See 
Figure A-8 below.

“G” that matches 
reference 
nucleotide is 
displayed in black.

“G” that is a variant 
highlighted in black 
and nucleotides are 
displayed in white.

Variant nucleotide remains highlighted.
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Blocks is selected, then these indicate the colors for the nucleotide backgrounds.

• For Deletions: No nucleotide is displayed. Instead, a burnt orange dash is displayed.

• For Insertions: If Variants is selected, then the nucleotide is displayed in purple. If 
Blocks is selected, then the nucleotide background is purple.

• If coverage areas fall below the Total Coverage value that is specified for the Filter 
Settings: If Variants is selected, then a gray “N” is displayed for the consensus 
sequence in these regions. If Blocks is selected, then the nucleotide background is 
displayed in gray and “N” is displayed in white. 

Figure A-9:  “N” indicating that coverage areas fall below the Total Coverage Value that is 
specified in the Filter Settings

1. On the Application Settings dialog box, ensure that the Global Viewer sub-pane is 
visible.

2. Do any or all of the following as needed to edit the variant visibility and/or change colors 

• Adjust the value for Variant Visibility. 

• To make the non-variant nucleotides more visible in the pane display when both 
Blocks and Variants are selected, increase the value. 

• Conversely, to make the non-variant nucleotides less visible in the pane display 
when both Blocks and Variants are selected, decrease the value. You can 
manually enter a new value, or you can use the Up/Down arrows.

• Change one or more colors for the nucleotides and/or variants. To do so, 
double-click the color swatch that is displayed for a nucleotide or variant type to 
open the Select Color dialog box, select a different color, and then click OK. 

Figure A-10:  Select Color dialog box

The Select Color dialog box closes and the Application Settings dialog box remains 
open. The newly selected color is displayed for the selected nucleotide or variant 
type. 
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3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed. 

To edit the Global Viewer pane colors

You can specify the colors that indicate coverage (forward, reverse, and/or low) and variant 
type (major or minor) in the Global Viewer pane of the Mito Alignment Viewer, where the 
default colors are the following:

• Forward coverage: Blue

• Reverse coverage: Red

• Low coverage: Gray

• Major variant: Green

• Minor variant: Burnt orange

1. On the Application Settings dialog box, ensure that the Global Viewer sub-pane is 
visible.

2. Double-click the color swatch that is displayed for a coverage type or variant type to 
open the Select Color dialog box, select a different color, and then click OK. 

Figure A-11:  Select Color dialog box

The Select Color dialog box closes and the Application Settings dialog box remains 
open. The newly selected color is displayed for the selected nucleotide or variant 
type. 

3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed. 
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To edit the Variants table (Report Table) Category colors

You can specify the highlighting colors for the different statuses of edited variants (added, 
removed, and so on) in the Variants Table of the GeneMarkerHTS viewer, where the default 
colors are the following:

• Added and Edit Caused Add: Light green

• Removed and Edit Caused Remove: Light red

• Called and Edited: Light blue

1. On the Application Settings dialog box, ensure that the Report Table Category sub-pane 
is visible.

2. Double-click the color swatch that is displayed for a variant status to open the Select 
Color dialog box, select a different color, and then click OK. 

Figure A-12:  Select Color dialog box

The Select Color dialog box closes and the Application Settings dialog box remains 
open. The newly selected color is displayed for the selected status. 

3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed. 

To edit the Comparison viewer variant highlighting colors

The Comparison viewer is divided into two panes: the Sample to Sample Comparison (top) 
pane and the Variant Comparison (bottom) pane. 

• You can specify the variant highlighting colors in the Sample to Sample Comparison 
pane, where the default colors are the following:

• Diagonal cells that compare a sample to itself are highlighted in black. 
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• All other cells in the correlation table compare one sample to another and are 
highlighted in a blue color gradient from 0 to 100%, where 0% cells are blank/white.

• You can specify the variant highlighting colors in the Variant Comparison pane, where the 
default colors are the following:

• Variants that can be classified as a major allele are highlighted in blue. 

• Variants that can be classified as a minor allele are highlighted in gold. 

• If a variant was determined to be a Low Coverage variant, the variant is highlighted 
in red.

Figure A-13:  Comparison viewer

1. On the Application Settings dialog box, ensure that the correct sub-pane, Comparison 
viewer: Sample to Sample or Comparison viewer: Variant, is visible.

2. Double-click the color swatch that is displayed for a variant highlighting color to open the 
Select Color dialog box, select a different color, and then click OK. 

Figure A-14:  Select Color dialog box

The Select Color dialog box closes and the Application Settings dialog box remains 
open. The newly selected color is displayed for the selected sample or variant type. 
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3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed.

To edit the STR Analysis viewer highlighting colors

You can specify the highlighting colors for the filter status and analyst reason for an STR in 
the STR Results Table pane of the STR Analysis viewer, where the default colors are the 
following:

• Flagged: Orange

• Passed: No highlighting (background is white)

• Filtered: Orange

• Called: Bright green

1. On the Application Settings dialog box, ensure that the STR Viewer sub-pane is visible.

2. Double-click the color swatch that is displayed for a variant highlighting color to open the 
Select Color dialog box, select a different color, and then click OK. 

Figure A-15:  Select Color dialog box

The Select Color dialog box closes and the Application Settings dialog box remains 
open. The newly selected color is displayed for the selected filter status or analyst 
reason. 

3. Do one of the following:

• If you are done specifying your settings, then click Save to close the Application 
Settings dialog box and return to the GeneMarkerHTS main window.

• Continue to edit other application settings as needed.
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B
BED file
Also known as Region of Interest (*.bed file). A BED file is a tab-delimited text file. You can 
upload a BED file only if the reference sequence contains chromosome information. Each 
row in the file contains a region of the reference that is to be used for the analysis, and at a 
minimum, the file must contain the following information:
• Field #1 - Chromosome number or name for the region (for example, chrM)
• Field #2 - Chromosome start position (for example, 300)
• Field #3 - Chromosome end position (for example, 305)
• Field #4 - Optional description column (for example, Region 102)
The positions are 0-based and open-ended. For example, a start of 10 and end of 15 would 
include reference positions 11, 12, 13, 14, and 15.

C
Consensus alignment
An optional alignment step. Because each read is considered on its own, indels that are near 
the end of reads are sometimes not correctly aligned. If this alignment option is selected, 
then an extra step is added after the initial alignment. In this extra step, indel positions are 
re-examined to possibly improve the alignment of these reads based on the alignment of 
other reads that have the indel.

M
Motif alignment
An optional alignment step. When equivalent sequences can be aligned in multiple ways 
(motifs), an analyst might not prefer the alignment method that the software selects. This 
step ensures that the selected motif is the motif that is defined by the motif file.

P
PCR duplicates
PCR duplicates are a set of pairs (paired-end data) or reads (non-paired-end data) that have 
been generated from the same original fragment. The “Remove PCR Duplicates” optional 
alignment step attempts to identify these reads and ignores all but one pair (or read) in each 
set.
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Personal Health Information (PHI)
Personal health information can be inferred from some regions of whole mtDNA sequence. 
To maintain privacy during whole mtDNA analysis, a BED file can be used to specify the 
positions that must be hidden from the analyst.

Proper Pairs
A pair of aligned reads is referred to as a “proper pair” if the reads are aligned on opposite 
strands in the correct orientation. Non-proper pairs can result from misalignment, 
sequencing error, or off-target amplification.
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